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Chapter 1:  Overview
This chapter describes the UWBTracer™ product and Ultra-Wideband technology in 
general. 

1.1 UWBTracer Ultra-Wideband Analyzers
The LeCroy UWBTracer is a portable Ultra-Wideband (UWB) test and debug platform 
that combines non-intrusive recording with extensive decoding features. The RF 
(wireless) recording functionality is designed to record non-intrusively off-the-air WiMedia 
UWB traffic from one or more devices, while the MPI recording functionality is designed 
to connect to the specification-defined MAC-PHY Interface (MPI) bus between the MAC 
and the PHY subsystems in WiMedia-compliant devices and to capture the traffic 
between them. 

By leveraging years of experience in protocol analysis tools for emerging markets, 
UWBTracer blends sophisticated functionality with practical features to allow designers 
and validation engineers to easily specify multi-level, conditional trigger scenarios to 
pinpoint intermittent problems in the UWB connection.

System-level validation requires non-intrusive monitoring. UWBTracer ensures accurate 
data collection by providing transparent electrical taps. At the heart of UWBTracer is the 
CATC BusEngine™ protocol processor that features a real-time recording engine for 
UWB MAC-to-PHY traffic.

UWBTracer also supports remote operation over a LAN and unattended control of the 
analyzer with an Automation API. UWBTracer includes an advanced search capability 
that allows to search for specific fields in the recorded trace and to navigate faster to 
places of interest inside the trace.

UWBTracer features a real-time statistics display that continuously monitors and 
presents metrics for the recorded MAC-to-PHY traffic, providing a high-level view of 
network performance. 

For complete product information, please visit www.LeCroy.com.
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Table 1.1 summarizes key UWBTracer features.

Table 1.1 UWBTracer Features

Feature Benefit

Wireless capturing & recording Allows off-the-air (and non-intrusive) recording of UWB 
traffic

 MPI capturing & recording Probes the WiMedia specification-defined bus between the 
MAC and PHY layers, while remaining non intrusive. 
Suitable for three different popular connector types.

Simultaneous RF and MPI 
recording

Capable of recording one RF and one MPI channel at the 
same time and display a combined trace

Advanced Triggering Robust capability of setting complex triggering and filtering 
sequences and act in real-time on those settings on each of 
the channels.

Trace View Comprehensive viewing of the recorded traffic with 
convenient customization through the trace display options.

Advanced search Fast and comprehensive trace searches.

Collapsible/expandable header Increased drill-down on exchanges, sequences, or individual 
frames.

Real-time performance monitoring 
and statistics

Allows easy identification of throughput problems and 
anomalies.

Dynamically-allocated memory 
pool

(2 GB) Captures long time-windows for analysis and 
problem-solving.

Interchangeable Radios and room 
for future expansion

The modular design of the UWBTracer™ and the CATC 5K 
platform permits interchanging modules and radios
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1.2 Ultra-Wideband Technology
UWB technology was available for over 40 years for military and civilian applications and 
was originally called either impulse radio or carrier-free communications. Today, the FCC 
definition for UWB is any radio technology with a spectrum that occupies greater than 20 
percent of the center frequency or a minimum of 500MHz. 

In 2002, the FCC allocated unlicensed radio spectrum from 3.1 GHz to 10.6 GHz 
expressly for enterprise and consumer applications. The FCC defined a specific 
minimum bandwidth of 500 MHz at a -10dB level. As current UWB implementations allow 
communication that requires high data rates over short distances, one immediate UWB 
application is WPAN (Wireless Personal Area Network).

The Multi-band OFDM technology, promoted by the WiMedia Alliance, is one of the 
technologies that can utilize the allocated band for UWB. The MB-OFDM transmits data 
simultaneously over multiple carriers spaced apart at precise frequencies. This approach 
provides benefits like high spectral flexibility and resiliency to RF interference and 
multi-path effects. 

The WiMedia Alliance drives the efforts to create an ecosystem that would allow easy and 
secure operation of UWB devices. A data-rate targeted at 480Mbps would provide the 
ground for delivering Wireless-USB (WUSB) devices. To complete the picture, the 
USB-IF organization is responsible for the effort to establish the WUSB specification.

The WiMedia UWB specifications are available from the WiMedia Alliance. The URL for 
the WiMedia website: 

http://www.wimedia.org
The WUSB specification is available from the USB Implementers Forum (USB-IF). The 
URL for the USB-IF website is:

http://www.usb.org/home
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Chapter 2:  Hardware Description
This chapter describes the CATC 5K-based UWBTracer™ analyzer and other 
components and accessories that accompany it.

2.1 CATC 5K Platform and the UWBTracer Analyzer
CATC 5K Platform
The CATC 5K platform has a modular design, as in previous CATC platforms. The 
lightweight platform is designed to be mobile. The flexible design is configurable through 
two front slots that accommodate up to two plug-in modules. The CATC 5K platform is 
powered by a small external power supply. Quiet built-in fans provide cooling.

UWBTracer Analyzer
The UWBTracer analyzer is composed of a CATC 5K platform and a UWB Analyzer 
plug-in module that is inserted into the right-side slot.

Connection to Host Machine
The CATC 5K platform connects to a Windows®-based PC (the host machine) through a 
USB cable. Though the system can operate over USB1.1 protocol data rates, it is 
advisable to use a USB2.0 connection between the Analyzer and the host machine to 
obtain faster upload of traffic.

2.2 System Components
Basic Components
The UWBTracer™ basic package includes the following components:

• Installation CD-ROM, with the installation program and all documents
• UWBTracer Getting Started manual, to help set up the system quickly
• CATC 5K Platform: See photograph on front cover. Also see “CATC 5K Front Panel” 

on page 13 and “CATC 5K Rear Panel” on page 14.
• CATC 5K Power Supply and Power Cord
• Vertical Stand 

Figure 2.1 Vertical Stand
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• UWB Analyzer Module, RF Antenna, and RF coaxial cable

Figure 2.2 UWB Plug-in Module with Antenna

• USB cable for connecting the analyzer to a host machine

Figure 2.3 Vertical Stand

• RF Coaxial Cable (SMA) [as part of the Standard Cable Kit] 

Figure 2.4 RF Coaxial Cable (SMA) [in Standard Cable Kit]
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• Synchronization Cable for synchronizing multiple analyzers

Figure 2.5 Synchronization Cable

• Trigger Cable (TRIG-IN/TRIG-OUT BNC Y-cable) for connecting to external equip-
ment (for example, for triggering capturing in a LeCroy oscilloscope). 

Figure 2.6 Trigger Cable

Optional Components
In addition to the basic package, optional components are available:
• Carrying case
• MPI Kit (please refer to the Data Sheet for detailed information) 
• UWB Analyzer plug-in module with support for different radio vendors

MPI Kit
The MPI kit is designed for hooking to the MPI bus in two types of setups:
1. PHY subsystem connects to the MAC subsystem through a short (ribbon) cable.
2. PHY subsystem piggybacks directly on the MAC subsystem. The two subsystems 

connect through an adapter board without the use of cables.

Three types of connectors are common for current designs:
1. IDE 40-pin connector
2. Hirose 68-pin Connector
3. Hirose 60-pin Connector
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The optional MPI Kit includes: 

Figure 2.7 MPI Kit

• Adapter Cable (SCSI) 

Figure 2.8 Adapter Cable (SCSI)
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• Probe Cable for IDE 40-pin Connectors and Hirose 68-pin Connectors (2) 

Figure 2.9 Probe Cable for IDE 40-pin Connectors and 
Hirose 68-pin Connectors

• Cable Adapter for Hirose 68-pin or IDE 40-pin Connectors 

Figure 2.10Cable Adapter for Hirose 68-pin or IDE 40-pin Connectors

• Board Adapter for IDE 40-pin Connectors 

Figure 2.11 Board Adapter for IDE 40-pin Connectors
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• Board Adapter for Hirose 68-pin Connectors 

Figure 2.12Board Adapter for Hirose 68-pin Connectors

• Board Adapter for Hirose 60-pin Connectors 

Figure 2.13Board Adapter for Hirose 60-pin Connectors
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2.3 Connecting Cables and Adapters
Figure 2.14 shows the connections among CATC 5K, UWB Analyzer, connectors, and 
cables. 

Figure 2.14Example UWBTracer Device Connections Diagram 
for Recording MPI Traffic from Devices using the IDE 40-pin 
Cable Adapter
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To use the Cable Adapter to connect with an IDE 40-pin connector:
Step 1 Turn of the power on the analyzer and the device-under-test

Step 2 Connect the middle connector on the IDE 40-pin Probe Adapter to the 
40-pin connector on the Cable Adapter.

Step 3 Connect one of the end connectors on the IDE 40-pin Probe Adapter to 
the PHY subsystem.

Step 4 Connect the other end connector on the IDE 40-pin Probe Adapter to the 
MAC subsystem.

Step 5 Connect the Adapter Cable (SCSI) to the MPI ADAPTER connector on 
the UWBTracer plug-in.

Step 6 Connect the Adapter Cable (SCSI) to the TO ANALYZER connector on 
the Cable Adapter unit.

Step 7 Turn on the power, then start capturing data.

To use the Cable Adapter to connect with a Hirose 68-pin connector:
Follow the same steps as for the IDE 40-pin connector, but use the Hirose 68-pin Probe 
Cable and the 68-pin connector on the Cable Adapter.

To use the Board Adapter to connect with a IDE 40-pin connector:
Step 1 Turn off the power on the analyzer and the device under test.

Step 2 Connect one side of the IDE 40-pin Board Adapter to the connector on 
the MAC subsystem. 

Step 3 Connect the PHY subsystem to the other IDE 40-pin connector on the 
Board Adapter.

Step 4 Connect the Adapter Cable (SCSI) to the MPI ADAPTER connector on 
the UWBTracer plug-in.

Step 5 Connect the other side of the Adapter Cable (SCSI) to the connector on 
the Board Adapter.

Step 6 Turn on the power, then start capturing data.

To use the Board Adapter to connect with a Hirose 68-pin 
connector:
Follow the same steps as for the IDE 40-pin connector, but use the Hirose 68-pin Board 
Adapter.

To use the Board Adapter to connect with a Hirose 60-pin 
connector:
Follow the same steps as for the IDE 40-pin connector, but use the Hirose 60-pin Board 
Adapter.
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2.4 UWBTracer Front Panel Description
When powered ON, the CATC 5K Analyzer activates user-accessible controls and LEDs 
on front and rear panels of the platform. This section covers front panel features. The next 
section covers rear panel features.

Figure 2.15CATC 5K Front Panel

CATC 5K
The indicators (Figure 2.15) are:

STATUS (status of the platform)

UWB Analyzer
LEDs (status of the MPI or RF channel)

Connectors
The connectors are:

• MPI ADAPTER: Connector to MPI Adapter
• ANT: SMA Connector for Antenna

LED Description
No light System is not powered on

Green Blink Slow Initializing

Blue System is operational

Red Blink Fast System fault (contact Support)

LED State MPI Channel  RF Channel
No light Idle Does not detect PCLK or 

PHY_ACTIVE
Does not detect wireless 
frames

Yellow Blink Fast Synching Trying to synchronize to 
MPI traffic and waiting for 
PCLK and PHY_ACTIVE

Trying to synchronize to 
RF traffic and waiting for 
wireless traffic

Yellow Synched Synchronized:
Capturing MPI traffic with 
PHY_ACTIVE signal high

Synchronized:
Capturing wireless frames

Red Blink Slow Recording
Pre-Trigger

Recording
Pre-Trigger traffic

Recording
Pre-Trigger traffic

Red Recording
Post-Trigger

Recording
Post-Trigger MPI traffic

Recording
Post-Trigger wireless 
traffic
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2.5 UWBTracer Rear Panel Description
From left to right, the rear panel contains the following components: 

Figure 2.16CATC 5K Rear Panel

• SYNC IN/OUT: For synchronized multi-analyzer operation, the analyzers must be 
connected in a daisy-chain topology to each other using the green/purple cable.

• EXT DATA: For attaching the TRIG-IN/TRIG-OUT BNC Y-cable (Trigger Cable) to 
external instruments

• HOST: For connecting the analyzer through USB to the host machine
• POWER 12 VDC: For connecting the external power supply to the analyzer. 

Note: There is no power switch on the analyzer.

Warning!  Do not open the CATC 5K enclosure. No operator 
serviceable parts are inside. Refer servicing to LeCroy. 
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2.6 RF Recording Setup
For wireless recording, the UWB Analyzer uses the UWB radio on the UWB analyzer 
plug-in. The plug-in module must be inserted into the right-side slot of the CATC 5K 
platform. 
There are two options for eavesdropping UWB traffic:
• Wireless RF recording
• Wired RF Recording

Wireless RF Recording
Using the provided RF antenna, the analyzer can capture over-the-air wireless traffic. 
Perform the following steps:
Step 1 Make sure the antenna provided with the UWBTracer analyzer is tightly 

connected to the connector marked ANT.

Step 2 Position the analyzer and devices under test at an equal distance from 
each other, 10 inches apart (Figure 2.17). 

Figure 2.17Wireless RF Recording

Note: RF signals and noise from external devices might affect wireless recording, as 
might the transmit and receive patterns of antennas on the analyzer and devices under 
test. If the recorded trace has many corrupted UWB frames, try the following:

• Try different positions of the devices and analyzer.
• Place the devices and analyzer as close as possible to each other and at equal 

distance (but not less than 10 inches apart).
• Remove any potential RF radiators from the test environment or find an RF-quiet 

location. 
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Wired RF Recording
Wired RF Recording can be used when the test setup requires isolation from external RF 
interference or when the effects of the antennas need to be negated. In this setup, coaxial 
cables are used to connect the analyzer to the devices under test.

To match the transmit power of the radios to the receive power ratings (because 
low-impedance wires are now used), use attenuators to lower the signal strength so that 
the input stages of the PHYs are not saturated (Figure 2.18). The –20 dB attenuators are 
given as an example. You might need to use different attenuators depending on the 
characteristics and signal strength of the radios in use.

Figure 2.18Wired RF Recording

Note:  The attentuator values shown are only examples. You may need to 
use different values according to the PHYs used, their signal 
strengths, and your setup.
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Chapter 3:  Software Overview
The UWBTracer™ software can: 

• Control recording of UWB traffic.
• Manage one or more Analyzers, which can be connected directly to the host 

machine or connected through the Analyzer network.
• View, analyze, and create reports about recorded traces. 

3.1 Installing the Software
For instructions about installing the software, refer to the UWBTracer Getting Started 
manual.

3.2 Starting the UWBTracer Program
You can use the UWBTracer with or without the analyzer unit. When used without an 
analyzer, the program works as a trace viewer to view, analyze, and print trace files. 

To start the UWBTracer Program from the PC Start menu: 

Step 1 Select Start > Programs > CATC > LeCroy UWBTracer
to display the application main window (Figure 3.1). 

Figure 3.1 UWBTracer Main Window
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3.3 Opening Sample Traces
A good way to gain familiarity with UWBTracer is to open some of the provided sample 
files and explore the menus, pop-up menus, and reports. 

3.4 Opening Older Trace Files
The UWBTracer software has the capacity to open trace files created with earlier 
software versions. When an older trace file is opened, the program prompts you to 
convert the file to the current software version.

3.5 Tool Tips
Throughout the application, Tool Tips provide useful information about buttons on the 
toolbar.

To display a Tool Tip, position the mouse pointer over an item of interest such as part of 
the trace or a button (Figure 3.2).

Figure 3.2 Tool Tip

3.6 Trace Tool-Tips
Many fields within the Trace display tool-tips when the mouse pointer is suspended over 
them. These tips may provide a simple legend for the cell or may give substantial added 
details about the field (Figure 3.3). 

Figure 3.3 Trace Tool Tip
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3.7 Menu Bar
Table 3.1 lists menus available from the Main window menu bar. Some menus and 
options are available only when a file is open.

Table 3.1 Menu Bar Menus 

Menu/Option Function

File

Open Opens a trace file or traffic generation file.
Close Closes the current trace or generation file.
Save As Saves all or a specified range of frames with a specified name.
Print Prints part or all of the current trace or traffic generation file.
Print Preview Produces an on-screen preview before printing. 
Print Setup Sets options for the current or new printer.
Edit Comment Opens a dialog for entering a brief comment about the trace.
Export Packets to Text (Packet View Format) - Saves all or part of a trace to a 

text file. Used to save traces to floppy disk and to send in e-mail.
Packets to CSV Text - Saves trace as a comma-separated-values text 
file for use with Microsoft® Excel.

Exit Exits the UWBTracer program.

Setup

Display Options Opens a window that controls the recording process.
Recording Options Opens a window that controls display options.
Update BE/FW Update BusEngine™ and Firmware manually 
Analyzer Network Opens a dialog box for browsing to local and networked analyzers. 

Within the dialog, click Add to browse. The dialog lists PCs that are on 
the LAN. If a PC has an analyzer attached to it, and if DCOM 
permissions have been set on the selected PC, clicking Select 
establishes a connection. 

All Connected
Devices

Opens a dialog box with a list of analyzers connected to the host PC. 
Lets you select an analyzer and update the BusEngine, Firmware, and 
licensing information.

Record

Start Causes the Analyzer to begin recording.
Stop Causes the Analyzer to stop recording.
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Report

File Information Displays information about the recording such as the number of frames 
and triggering setup.

Error Summary Displays the Errors report of the Traffic Summary, listing the numbers of 
each error type.

Timing Calculations Calculates timing between two frames.
Traffic summary Summarizes the numbers and types of errors, packets, transactions, 

split transactions, and transfers that occurred in the open trace.
Device List Lists the DUTs, active devices, archive devices, and wireless USB in the 

Device List window by DUTs, Type, EUI-48, Address, Alias, 
Last Updated, and User Notes. 

Search

Go to Trigger Positions the display to show the triggering event at the top.
Go to Frame/
Packet/Transaction/
Transfer

Positions the display to show a specific frame or decode level.

Go to Marker > Positions the display to the selected marked frame.
Go to > Positions the display to the specified item.
Find Allows searches by multiple criteria.
Find Next Looks for the next instance of an event specified with Goto or Find.
Search Direction Allows the search direction to be changed from Forward to Backward or 

Backward to Forward. 

Menu/Option Function
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View

Toolbars Displays list of available Tool bars.
Analyzer Network 
Chat Bar

Opens a dialog that allows users to conduct chat sessions over an IP 
LAN. In order to send and receive electronic text messages, each user 
must be working with a PC that is on an IP LAN and also attached to an 
analyzer.

Status Bar Switches display of the Status Bar ON or OFF.
Hide Traffic on 
Channels

Hides traffic on the channel (MPI or RF) selected from the popup list.

Hide Reserved 
Field Warnings

Hides fields that have a Reserved Field Warning. 

Unhide Cells Unhides the cells (hidden by Display Options) selected from the popup 
list. 

Zoom In Increases the size of the displayed elements.
Zoom Out Decreases the size of the displayed elements.
Wrap Wraps displayed Frames within the window.
Apply Decoding
Scripts

Decoding scripts set the values of the display and recording options for 
optimum views of trace information from specific vendors or classes of 
data. The menu allows you to select the vendor or class of data for the 
request recipients and endpoints listed in the Request Recipients and 
Endpoints menu. You can keep the settings across recordings.

Real-Time Statistics Displays trace statistics.

Window

New Window Opens another instance of the Main Window.
Cascade Displays all open Main windows in cascaded format.
Tile Horizontal Displays all open Main windows in tiled horizontal format.
Tile Vertical Displays all open Main windows in tiled vertical format.
Arrange Icons Arranges Main window icons at bottom of display area.
Windows Displays a list of open windows.

Help

Help Topics Opens online help.
Update License Opens a dialog box for entering license key information for the analyzer.
Display License 
Information

Opens a dialog box with information about the current status of the 
analyzer's license

About Displays version information about UWBTracer.

Menu/Option Function
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3.8 Tool Bar
The Main window Tool bar provides quick access to most UWBTracer software functions. 
You can learn the function of each button by passing the mouse pointer over it. Button 
descriptions appear on the Status bar at the bottom of the window and as tooltips above 
each button. 

Figure 3.4 Main Window Toolbar

General Buttons 

Hide Buttons 

Open file Zoom In

Save As Zoom Out

Setup Recording Options Wrap

Setup Display Options Find

Start Recording Find Next. Repeats last find.

Stop Recording Apply Decoding Scripts

Manual Trigger

Hide Unassociated Traffic Hide Beacon Frames

Hide Devices
Hide MMC Packets with Empty DN 
frames

Hide Empty Super Frame Hide Channels (MPI or RF)
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Reports Buttons 

Decode Buttons 

3.9 Floating the Decode Toolbar
You can float any of the toolbars by dragging them from their current location at the top 
of the screen. If you float the decode toolbar, it arranges the decode buttons in their 
hierarchical order. Click the triangle to add or delete buttons. 

Figure 3.5 Decode Toolbar in Hierarchal Arrangement

File Information Report. Opens a 
summary of general information 
about the trace file.

Traffic Summary. Opens a summary 
of protocol-related information in the 
trace file.

Error Report. Opens a summary of 
error information in the trace file.

Bus Utilization. Opens a window that 
shows packet length by time.

Timing and Bus Usage 
Calculations. Opens a calculator for 
measuring timing between frames

Real-Time Statistics. Opens a window 
that shows realtime information on 
links activity.

Device List Window

View MPI Trace Level View WUSB Transaction Level

View WUSB Packet Level View WUSB Transfer Level

View WUSB WA Segment Level View WUSB WA Transfer Level

Triangle to add or delete buttons



Chapter 3: Software Overview UWBTracer User Manual

24 LeCroy Corporation

3.10 Pop-Up Menus
Pop-up menus within the trace provide options for formatting the trace. 

Left Mouse Button
Left-clicking a header opens a menu for expanding fields, viewing data fields, and 
formatting the trace. The menu is context-sensitive and changes, depending on what part 
of the trace you have clicked. Figure 3.6 shows three examples. 

Figure 3.6 Trace Pop-Up Menus

Common options appear on most menus: 

• Format: Presents choices for changing the numerical formatting of the data fields 
throughout the trace.

• Color: Presents choices for changing the color of the data fields throughout the 
trace.

• Hide: Hides data fields throughout the trace. To re-display hidden fields, right-click 
anywhere in the trace and select Unhide Cells and then one of the options from the 
sub-menu.
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Left-clicking the small triangle in the upper left corner of the PHY, MAC, Payload, or 
Timing data block expands the data block to show all fields.

Figure 3.7 Expanded Data Block

If you double-click a cell of a PHY, MAC, Payload, or Timing data block, the trace displays 
all the fields of the block (see Figure 3.7). If you double-click a cell of an expanded block, 
the trace displays the truncated block 

Right Mouse Button
If you right-click a cell in the trace, a pop-up menu allows changing display options, 
zooming in or out, wrapping the display, unhiding hidden cells, hiding fields with reserved 
field warnings, applying decoding scripts, and calculating real-time statistics (Figure 3.8). 

Figure 3.8 Trace Cell Pop-up Menu
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3.11 Status Bar
The Status bar is located at the bottom of the Main window. Depending on the current 
activity, the bar can be divided into as many as four segments. Figure 3.9 shows an 
example status bar. In this example, no analyzers are connected to the application.

Figure 3.9 Status Bar Example 1

In Figure 3.10, an analyzer is connected to the application. Both the MPI and RF 
channels are in IDLE state.

Figure 3.10Status Bar Example 2

In Figure 3.11, the MPI channel detects PCLK and is attempting to synchronize to the 
data. The RF channel is in IDLE state.

Figure 3.11 Status Bar Example 3

The MPI Channel is synchronized to the MPI data and PCLK. The RF channel is 
attempting to synchronize to wireless traffic.

Figure 3.12Status Bar Example 4

The MPI channel is synchronized to the MPI traffic and is recording. The RF channel is 
recording but lost synchronization and is attempting to regain synchronization.

Figure 3.13Status Bar Example 5

The MPI channel is in IDLE mode, not synchronized to PCLK. The RF channel is 
synchronized to wireless traffic and is recording.

Figure 3.14Status Bar Example 6
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Recording Progress
When you begin recording, the left-most segment of the Status bar displays a recording 
Progress Indicator (left side of Figure 3.15). 

Figure 3.15Example: Status Bar at Different Recording States

Keep the following in mind when reading the Progress Indicator:

• A black vertical line illustrates the location of the trigger position you selected in the 
Recording Options window. The pre-trigger progress is displayed in the field to the 
left of the trigger position. 

• When the trigger position is reached, the progress indicator wiggles as it waits for 
the trigger. 

• After the trigger occurs, the field to the right of the trigger fills in the post-trigger color 
specified in the Display Options window.

• When recording is complete, the upper half of the Progress Indicator fills in white, 
indicating the progress of the data upload to the host computer.

Some other key points about the Progress Indicator:

• If a trigger event occurs during the before-trigger recording, the before-trigger color 
changes to the after-trigger color to indicate that not all the expected data was 
recorded pre-trigger. 

• When you click Stop before or after a trigger event, the Progress Indicator adjusts 
to begin uploading most recently recorded data.

• If you wish to abort an upload that is in progress, click the Stop button again.
• The Progress Indicator fills with color in proportion to the specified size and actual 

rate at which the hardware is writing and reading the recording memory. However, 
the Progress Indicator is normalized to fill the space within the Status bar.

Recording Status
During recording, current recording status is displayed in the next segment of the Status 
bar. When recording is begun, one of the following messages flashes (depending on 
options selected in the Recording Options window):

• Trigger?
• Triggered!
• Uploading
After recording stops, the following occurs:

• Flashing message changes to Uploading data–x% done (x% indicates the per-
centage completion of the data uploading process). 

• Traffic data is copied to disk (overwriting any previous version of this file) using the 
default file name data.uwb. You can specify the file name in the Recording Options 
window.
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To abort the upload process, press the Stop button. You are asked if you want to keep 
or discard the partially uploaded data.

When the data is saved, the Recorded Data file appears in the Main display window, and 
the Recording Status window is cleared. 

• If the recording resulted from a trigger event, the first frame following the trigger (or 
the frame that caused the trigger) is initially positioned second from the top of the 
display.

• If the recording did not result from a trigger event, the display begins with the first 
frame in the traffic file.

Recording Activity
During recording, the fourth segment from the left of the Status bar displays recording 
activity as a series of vertical bars. 

The more vertical bars that are displayed, the greater the amount of activity being 
recorded. If there are no vertical bars, there is no recorded activity. 

During uploading, the percent of the completed upload is displayed.

Search Status
The rightmost segment of the status bar displays current search direction: Fwd (forward) 
or Bwd (backward). 

3.12 View Settings Tools
You can zoom in and out, and wrap the trace to fit within the screen by using the following 
buttons:

Zoom In
Increases the size of the displayed elements, allowing fewer (but larger) Frame fields per 
screen. 

• Click on the Tool bar.

Zoom Out
Decreases the size of the displayed elements, allowing more (but smaller) Frame fields 
per screen. 

• Click on the Tool bar.
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Wrap
Adjusts the Trace View so that frames fit onto the next line if they are longer than the size 
of the window. Without wrap, you can use the horizontal scroll bar to see the hidden part 
of a frame.

• Click on the Tool bar. 
In Figure 3.16, the timestamp extends off the right edge of the screen. 

Figure 3.16Trace With Wrap Turned OFF

In Figure 3.17, the entire frame appears in the window.

Figure 3.17Trace With Wrap Turned ON

3.13 Adding Comments to the Trace
You can create, view, or edit the 100-character comment field associated with each 
Trace file.

Step 1 From the File menu, select Edit Comment to display the Edit Trace 
Comment dialog box. 

Figure 3.18Edit Trace File Comment Dialog Box

Step 2 Create, view, or edit the comment.

Step 3 Click OK.
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3.14 Set Marker
The Set Marker feature allows frames to be marked so you can navigate back to events 
of interest. Markers also provide you with a way of tagging events so you can perform 
timing calculations between them.

The Set Marker command works in conjunction with the Go to Marker feature. Once you 
have marked a frame, you can navigate back to it by selecting Search > Go to Marker, 
and then selecting the marker of interest from the list.

To set a marker on a frame: 

Step 1 In the trace, click the MPI field for the frame number you wish to mark.

Step 2 From the pop-up menu that appears, Select Set Marker (Figure 3.19). 

Figure 3.19Setting a Frame Marker

Step 3 The Edit Marker for Frame # dialog box appears (Figure 3.20).

Figure 3.20Edit Marker for Frame Dialog Box

Step 4 Enter your comment. 

Step 5 Click OK.
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Step 6 A marked frame is indicated by a vertical red bar along the left edge of 
the Frame # block (left side of Figure 3.21). 

Figure 3.21A Marked Frame

3.15 Edit or Clear Marker
To clear a marker or edit comments associated with a Frame marker: 

Step 1 Click Frame # for the chosen packet to display a pop-up menu 
(Figure 3.22). 

Figure 3.22Editing a Frame Marker

Step 2 To edit the marker comment, select Edit Marker.to display the Edit 
Marker for Frame # comment window (Figure 3.20).

Step 3 Edit the comment.

Step 4 Click OK.

Step 5 To clear a marker, click Clear marker in the frame pop-up menu 
(Figure 3.22). The vertical red Marker bar disappears.
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3.16 Timing Calculations on Markers
You can use markers as reference points to calculate timing between events. To do a 
timing calculation:

Step 1 Click the MPI field of the frame number that you want to use as the first 
point of reference in the time calculation.

Step 2 In the pop-up that appears (Figure 3.22), select Time from Marker to 
display the Timing and Bus Usage Calculator. The first point is in the 
From Frame field. 

Figure 3.23Timing Calculator Dialog Box
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Step 3 In the All Markers window, select the marker that you want to use as the 
second (To MPI) point of reference in the time calculation. 

Figure 3.24All Markers Window

Step 4 The time between the two markers appears in the Timing Calculator 
dialog box. 
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Chapter 4:  Reading Traces
This chapter describes how to read and manipulate trace displays.

4.1 Trace Display Overview
UWBTracer trace viewing software makes extensive use of color and graphics to fully 
document the captured (decoded) traffic (Figure 4.1). 

Figure 4.1 Trace Display Example

Frames are shown on separate time-stamped rows, with their individual fields both 
labeled and color coded. You can collapse data fields to save space in the display, and 
you can zoom in and out in the display. Pop-up Tool Tips annotate fields with detailed 
information about their contents.

The display software can operate independently of the hardware and so can function as 
a stand-alone trace viewer that may be freely distributed. 

4.2 Trace Level Views
You can display traces at these viewing levels, listed from lowest to highest: 

• MAC-PHY Interface Frame (MPI) [default]
• WUSB Packet (PKT)
• WUSB Transaction (TRA)
• WUSB Transfer (XFR)
• WUSB Wire Adapter Segment (WA SEG)
• WUSB Wire Adapter Transfer (WA XFR)
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Changing Trace Level Views
You can select the trace viewing level in the Display Options window General tab Trace 
Viewing Level section (see Chapter 6, "Display Options") or with the Trace Viewing Level 
icons in the Tool bar (Figure 4.2). 

Figure 4.2 Trace Viewing Level Buttons

Note:  To find frames, packets, transactions, segments, or transfers, scroll through 
the trace or use the Search > Find command (see Chapter 9, "Searching 
Traces").

MAC-PHY Interface Frame Level
The MPI view is the default decode level. An example MAC-PHY Interface Frame level 
is in Figure 4.3. Frame1 is marked. 

Figure 4.3 Trace View: MPI Frame Level

WUSB Packet Level 
Click the PKT button to show the WUSB Packet Level view. An example packet level is 
in Figure 4.4. 

Figure 4.4 Trace View: WUSB Packet Level
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WUSB Transaction Level
Click the TRA button to show the WUSB Transaction Level view. An example transaction 
level is in Figure 4.5. 

Figure 4.5 Trace View: WUSB Transaction Level

WUSB Transfer Level
Click the XFR button to show the WUSB Transfer Level view. An example transfer level 
is in Figure 4.6.

Figure 4.6 Trace View: WUSB Transfer Level

WUSB Wire Adapter Segment Level
Click the WASEG button to show the WUSB Wire Adapter Segment Level view. An 
example wire adapter segment level is in Figure 4.7. 

Figure 4.7 Trace View: WUSB Wire Adapter Segment Level
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WUSB Wire Adapter Transfer Level
Click the WAXFR button to show the WUSB Wire Adapter Transfer Level view. An 
example wire adapter transfer level is in Figure 4.8. 

Figure 4.8 Trace View: WUSB Wire Adapter Transfer Level
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Chapter 5:  Searching Traces
This chapter describes how to search for trace events.

5.1 Trace Search Overview
UWBTracer™ has several search commands that let you navigate a trace view to search 
for key events, such as errors and triggers. The commands are on the Search menu 
(Figure 5.1).

To view the search options, click Search in the Menu bar. 

Figure 5.1 Search Menu

5.2 Go to Trigger
To display a trigger event, select Go to Trigger from the Search menu.

The trace view is repositioned with the first frame following the trigger event (or the frame 
that caused the trigger) at the top of your screen.
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5.3 Go to PLCP/Packet/Transaction/Transfer
To display a specific frame or decode level, follow these steps:

Step 1 From the Search menu, select: 
Go to PLCP/Packet/Transaction/Transfer
to display the Go to PLCP/Packet/Transaction/Transfer dialog box (Figure 5.2): 

Figure 5.2 Go To PLCP/Packet/Transaction/Transfer Dialog Box

Step 2 Select the trace level view in the Go to field from the drop-down list. 

Step 3 Enter the number of the frame, packet, transaction, segment, or transfer.

Step 4 Click OK.
The trace view shows the selected item at the top of the main window.

5.4 Go to Marker
To instruct the analyzer to display a marked frame, follow these steps:

Step 1 From the Search menu, select Go to Marker (Figure 5.3). 

Figure 5.3 Selecting Go to Marker

Step 2 Select a frame or packet number from the listed markers. Alternatively, 
select All Markers to open the All Markers dialog box (see figure 5.17, 
"All Markers Window"), select a marker, and then click Select. 
The trace view displays the selected item at the top of the main window.
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Note:  The Go to Marker feature functions in conjunction with the Set Marker 
feature. The comments within the parentheses following each marked 
Frame are added or edited with the Set Marker feature. 

5.5 Go to
The Go to feature takes you directly to an item in the trace. After you select Go to, select 
the item from the listed items (Figure 5.4). 

Figure 5.4 Go to Items List
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5.6 Find
Find is a utility that allows you to conduct searches of one or more events in a trace. Find 
allows you to search for different hierarchical levels within the trace: the MPI frame level, 
WUSB packet level, WUSB transaction level, and WUSB transfer level.

To use Find: 

• Select Find... under Search on the Menu bar
OR

• Click in the Tool Bar.

You see the User-Defined Find Events window (Find window) (Figure 5.5).

Figure 5.5 Find Events Window



UWBTracer User Manual Chapter 5: Searching Traces

LeCroy Corporation  43

Areas in Find Window
The Find window has three areas: Event Groups pane, a Context area to the right of the 
Event Groups pane (whose contents vary depending on items in the pane), and a 
Direction/Origin area at the right in the window.

Event Groups Pane: Left area that allows you to specify the events to find in the search. 
You can select as many checkboxes as desired (for multiple search events). You also 
can combine specified event groups, meaning you can use logical relationships in your 
search: OR, AND, and NOT: 

• Union: OR relationship. A Find operation searches for frames that include any of 
the items selected in the Event Groups pane.

• Intersection: AND relationship. A Find operation searches for only those frames 
that match all the items selected in the Event Groups pane.

• Exclusion: NOT relationship. A Find operation searches for frames that do not 
match any of the items selected in the Event Groups pane. 

Context area: Provides further selection criteria for the Event Group active in the Event 
Groups pane. For example, in Figure 5.5, the MAC Destination Addresses Event Group 
is currently active (selected). The context area lets you select a range of MAC addresses. 
In Figure 5.6, the PHY Data Rates is the active Event group. A different display appears 
in the context area. 

Figure 5.6 Find Events Window: MPI Bus States Active
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Direction/
Origin

The radio buttons and checkboxes in the right part of the Find window let you specify 
where you want to start the search and search direction: 

• Direction: You can search forward or backward in the file.
• Origin: You can choose the point-of-origin for the search.
• Find All: You can extract every instance of the search criteria in a separate trace 

file.
• Search in Hidden: You can search in frame elements that are hidden in the display 

as well as frame elements that are visible.



UWBTracer User Manual Chapter 6: Display Options

LeCroy Corporation  45

Chapter 6:  Display Options
You can select what information to display in Trace Views using the Display Options 
window or the display options buttons on the Tool bar (see Section 3.8, “Tool Bar” on 
page 22).

To open the Display Options window: 

• Select Display Options under Setup on the Menu Bar.
OR

• Click on the Tool Bar.

Figure 6.1 Display Options Window: General Page

You can select General and Color/Format/Hiding display options. The following sections 
describe these display options.
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6.1 Display Options: General
You specify the main Trace View information types and settings using General tab of 
Display Options (see figure on previous page): 

• Zoom Level: Zooms out from 100% (default) to 10% or zooms in from 100% to 
200%.

• Enable Tips: Pops up text when you position the cursor over a field.
• Wrap: Wraps lines of traffic information instead of truncating lines at the right edge 

of the display.
• Right click cell context menu: By default, clicking the left mouse button on a field 

heading displays a context-sensitive pop-up menu providing commands about the 
field and clicking the right mouse button pops up a menu with display options. After 
selecting this option, clicking the right mouse button on a field heading displays the 
context-sensitive pop-up menu and clicking the left mouse button does nothing.

• Hierarchy Lines: Displays lines on the left side of Trace View showing the hierar-
chy from Packets to Transactions to Transfers if you show higher-level decodes. 

Figure 6.2 Hierarchy Lines

• Timestamp At The Beginning: Aligns the Timestamp field in a column on the left 
side of the Trace View. Selecting this option allows easier comparison with previous 
or following timestamps.

• Trace Viewing Level: Displays MAC-PHY Interface Frame, WUSB Packet level, 
WUSB Transaction, WUSB Transfer, WUSB Wire Adapter Segment, or WUSB Wire 
Adapter Transfer Level.

• Error Report: Displays the Errors section of the Traffic Summary window. 
• Traffic Summary: Displays the Traffic Summary window, showing all reports, 

including Packets, Transactions, Transfers, and Errors. 
• Bus Utilization: Displays the Bus Utilization window, including Packet length, Bus 

usage, and Bus usage by device. 
• Real-Time Statistics: Displays the Real-Time Statistics window, including Data 

Packet Count, Data Payload Throughput, and Bus Usage. 
• Fonts: Sets the font type and bold or italic style for Fields and Data.
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• Configuration Name: You can name the current set of Display Options values for 
use with an .opt file. (The options file can have a different name.)

• Restore Factory Presets: Sets all Display Options values to the installed values. 

6.2 Display Options: Color, Format, and Hiding
To modify the colors, formats, and hiding options, select the Color/Format/Hiding tab. 

Figure 6.3 Display Options Window: Color, Format, and Hiding Page

Setting Colors
The program uses a default set of colors for each type of data in each group of data. The 
colors and color combinations are appropriate for most graphic systems. You can alter 
any color.

To specify a color for an information type, in the Color/Format/Hiding tab, select a row 
(such as Data) in the Group and Color column and expand it (see Figure 6.2). 

Select a data type (such as Data Length) in the Group, then select a color in the Color 
section, using Standard or Custom colors. Use a bright color for each important field 

To customize colors, use the Custom tab.
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Note:  You cannot change color of an Invalid Data (packet error) field. It is 
permanently set to red.

Changing Field Formats
For each type of data in each group of data, the program has a default data format. 
Examples of number data formats are Bin (binary), Dec (decimal), and Hex 
(hexadecimal). Examples of date and time data formats are Hex uFrame, Dec uFrame, 
Date & Time, Time, Bit Time, seconds, microseconds, and nanoseconds. An example of 
a text data format is ASCII. You can alter some data formats.

To specify a data format for an information type, in the Color/Format/Hiding tab, select a 
row (such as Data) in the Group and Color column and expand it. 

Select a data type (such as Payload) in the Group: 

Figure 6.4 Group and Color Pane: Display Units Selected

Select a format in the Format section. The following formats are available for Payload: 

Figure 6.5 Formats for Payload

If available, select Bit Order in the Format section. The options are MSB to LSB or LSB 
to MSB.
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Hiding Fields
To hide one or more fields, select the Group and Data type in the Group and Color 
column, then click the Hidden checkbox in the display or the Hidden checkbox in the 
Hiding section of the Format section.

Figure 6.6 Hidden Check Box

6.3 Saving Display Options 
You can save a set of Display Options values, make a set the default settings, or use a 
saved set of values with the commands at the bottom of the Display Options window: 

• To save the current Display Options values in an options file for use in future ses-
sions, click Save. Enter a file name without a file name extension. The program 
adds the .opt extension. (The file must have an .opt file name extension.)

• To load a previously saved .opt file, click Load and select a file name.
• To save the current Display Options values in the default.opt options file for use as 

the default display options, click Save as Default. (Do not delete the default.opt 
file.)

• To apply the current Display Options values, click Apply. The Display Options win-
dow remains open.

• To apply the current Display Options values and close the Display Options window, 
click OK.

• To cancel unsaved changes to display values and exit the Display Options window, 
click Cancel. 
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Chapter 7:  Recording Options
The recording options are the parameters for the recording session. You set the 
recording options to obtain only the trace information you need. 

To use the Recording Options window: 

• From the Setup menu, select Recording Options.
OR

• From the Tool bar, select the Recording Options button to display the 
Recording Options window (Figure 7.1). 

Figure 7.1 Recording Options Window: General Page

The Recording Options window has three tabs: 

• General: General recording characteristics, including buffer size, recording type, 
and Trace filename and path.

• RF & MPI: Specific recording characteristics.
• Recording Rules: Sets triggers and filters.

Note:  The settings you configure apply to all recordings made by the analyzer.
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You can save and load recording options. The following sections describe the General, 
RF & MPI, and Recording Rules tabs.

7.1 Recording Options: General
The General page has boxes for Recording Type, Options, Options Name, and Trace 
Filename and Path.

Recording 
Type

Recording begins when you click the Start Recording button on the Tool bar or 
select the Record > Start command. Maximum recording size is set in the Buffer Size 
box. 

The Recording Type box options control how UWBTracer ends a recording: 

• Snapshot: Recording ends when the length reaches the selected

buffer size or you click the Stop Recording button . 
• Manual Trigger: Recording continues until you press the Trigger button (on the 

front panel). After you press the Trigger button, recording continues until the 
post-trigger buffer is full or you click

the Stop Recording button on the Tool bar.
• Event Trigger: Recording continues until a (user-defined) trigger event occurs. 

After the event occurs, recording continues until the post-trigger buffer is full.

Note:  See the Readme file on the software installation CD for current information 
on triggering support.

Options The options checkboxes appear on the upper right side of the Recording Options 
window: 

• Beep When Trigger Occurs: Makes the computer connected to the UWBTracer 
beep three times when a Trigger condition is first detected.

• Save External Interface Signals: Records signals from data pins on the breakout 
board.

Misc button
To generate an additional binary file at the end of recording: 

Step 1 Select the Misc button to display the General: Miscellaneous dialog 
box.

Step 2 Select the Store into Raw Data Debug file checkbox. 

The file is stored in the root (c:\) directory. The file name is 
BusEngineRawTracexxxx.dat, where xxxx is the serial number of the analyzer. Use the 
file to provide additional information if you want to report a problem to LeCroy Technical 
Support.

Warning!  :The Raw Data Debug binary file can have a very large size. 
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Buffer Size
The program records the entire trace and stores it in the analyzer buffer before uploading 
it to the host PC. The buffer size determines the maximum size of a recording. 

Use the Buffer Size slide bar to set the recording buffer size from 1.6 MB to 2048 MB 
(Figure 7.2). 

Figure 7.2 Recording Options Window: Buffer Size Slider

Trigger Position
The program uses Trigger Position when the recording type is Manual Trigger or Event 
Trigger.
Use the Trigger Position slide bar to set the percentage of the buffer size used for 
post-trigger recording (Figure 7.3). 

Figure 7.3 Recording Options Window: Trigger Position Slider

This action sets the location of the trigger within the buffer. For example, if the buffer size 
is 16 MB and the trigger position slide bar is at 75%, 12 MB of the buffer (75%) is 
post-trigger and 4 MB is pre-trigger. If the buffer size is 16 MB and the trigger position 
slide bar is at 5%, 0.8 MB of the buffer (5%) is post-trigger and 15.2 MB is pre-trigger. 

When a trigger occurs in a recording, recording continues until the post-trigger buffer is 
full. The complete trace contains the most recent pre-trigger information up to the 
pre-trigger buffer size, followed by the post-trigger information up to the post-trigger 
buffer size.
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Options Name
You can name the current set of recording options in the Options Name field. 

By default, the UWBTracer™ application uses the default.rec recording options file 
located in the application directory. You can save the current recording options in an 
options file in the application directory or save the recording options as the default file by 
replacing the default.rec file. 

To create a new recording options file: 

Step 1 Click the Save button to display the Save As dialog box.

Step 2 Enter a file name. You can use the same name or a different name than 
the name in the Options Name field. Do not add a file name extension. 
The program automatically appends a .rec extension.

To save the current options as the default file: 

• Click the Save as Default button.

Trace Filename and Path
You can save the trace file recording in the Trace Filename and Path box. 

To create a trace file: 

Step 1 Click Change Default Location to display the Specify Trace File Name 
dialog box.

Step 2 Browse to or enter a trace file path and name, then click Save.
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7.2 Recording Options: RF & MPI
You set RF and MPI recording options on the RF & MPI page (Figure 7.4). 

Figure 7.4 Recording Options Window: RF & MPI Page

RF
The RF section controls the RF recording channel. To turn on RF recording, check the 
RF checkbox in the upper left of the window.

Channel Sync Mode
For the analyzer to capture RF traffic, you must synchronize the RF transmission of at 
least one device under test (DUT). Use the Channel Sync Mode section to set the 
parameters required for synchronizing to a device.

Two modes of operation can be set: 

• Sync to Channel: Directs the analyzer to attempt to synchronize to a specific 
channel. In this mode, you can only select a single channel in the Select Sync  
Channel window displayed after you click the Set button.

• Scan Channels: Directs the analyzer to scan the first of multiple channels and 
synchronize to the transmission on that channel for a specified period of time, then 
repeat for the remaining channels. In this mode, you can select multiple channels in 
the Select Sync Channel window displayed after you click the Set button. The 
system stops recording automatically after all selected channels have been 
scanned.
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To select the channel or channels, click Set to display the Select Sync Channel(s) dialog 
box: 

Figure 7.5 Select Sync Channels Dialog Box

The dialog box lists the Channel, Band Group/TF Code, and Band IDs.

Select a checkbox on the left to select a channel. When you are finished selecting 
channels, click OK.

Device Tracking
After the analyzer is initialized/synchronized to a device or a channel, if the DUT changes 
channels, the analyzer can follow a specific DUT or it can stay on the same channel and 
follow a beacon switch or a burst preamble of the DUT(s). The device tracking options 
are:

• Follow Channel Change: The analyzer follows the DUT if it changes to a different 
channel.

• Follow Beacon Switch: The analyzer follows a  beacon switch of the DUT(s).
• Follow Burst Preamble: The analyzer follows a burst preamble of the DUT(s).

Devices to Track
Several DUTs may share the same channel to which the analyzer is synchronized. You 
can set the analyzer to follow one or a subset of those DUTs.

To select a subset of the devices, you can select from a list of DUTs. Alternatively, you 
can filter a subset from the set of devices by setting the MAC Address Mask and the 
SrcID (Source ID) Mask. Only the devices matching the properties you set will be in the 
subset of devices.

To set the devices to track, select Any Device or Only DUT. If you select Only Device, 
select the device from the list of devices. The MAC Addr (Address) Mask and the 
SrcID (Source ID) Mask are listed in hexadecimal.
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MPI
For MPI recording, select the MPI checkbox at the top left of the MPI section in the lower 
left corner of the window.

By default, a trigger occurs on the negative edge of the PCLK clock pulse. If recording 
data is corrupt, you can set a trigger to occur on the positive edge of the PCLK clock pulse 
by deselecting the Samples on Negative Edge of PCLK checkbox in the Signal Capture 
section in the lower left corner of the window.

To continue recording during reset, select the Continue capturing MPI signals during 
PHY Reset Cycle checkbox in the Signal Capture section in the lower left corner of the 
window.

Other Options
Scan Time per Channel
Set the scan period for each channel. The range is 0 to 64,000 milliseconds. The default 
is 1000 milliseconds. You can set this option only when the Channel Sync Mode is set to 
"Scan Channels."

Loss-of-Sync Timeout
Set the timeout period to use when out-of-synchronization occurs. The range is 
0 to 64,000 milliseconds. The default is 10,000 milliseconds.

Force Resynchronization
Resynchronizes the analyzer receiver PHY with the signal from the devices under test.

If the RF channel is already synchronized to transmitted data from a DUT, this setting 
forces the analyzer to terminate the synchronization and then try to resynchronize when 
a new recording begins.

Note:  If the analyzer is in "Scan Channels" Channel Sync Mode and you modify the 
channel setting, the software sets the Force Resynchronization flag 
internally.
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7.3 Recording Options: Recording Rules
Use the Recording Rules page (Figure 7.6) to set triggers and filters. 

Figure 7.6 Recording Options Window: Recording Rules Page

The page has the following areas: 

• Toolbar: Contains buttons that control the Recording Rules page.
• Available Events Area: Area where you can park Event buttons that you intend to 

use in the Main Display area.
• Main Display Area: Area where you configure trigger and filter rules. You configure 

rules by dragging Event buttons from the Available Events area and then assigning 
actions to those buttons. 

• Config Status Indicator: A button that indicates if the rule is valid or invalid. If a 
trigger or filter rule is configured correctly, the button is green and indicates Config is 
Valid. If a rule is not configured correctly, the button is red and indicates Config is 
Invalid.

• Pop-Up Menus (not shown): When you right-click a button or area in the Record-
ing Rules page, a context-sensitive pop-up menu appears that lets you do opera-
tions that relate to that button or area.

Toolbar

Main
Display
Area

Config
Status
Indicator 

Available
Events
Area
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Recording Rules Toolbar
The Recording Rules toolbar (Figure 7.7) buttons (Table 7.1 ) control the Recording 
Rules page. 

Figure 7.7 Recording Rules Toolbar

Table 7.1 Recording Rules Buttons 

Note:  If you have a wheel on the mouse, you can zoom by holding down the CTRL 
key and rolling the mouse wheel.

New Event. Creates a new 
event in the Available 
Events area.

Zoom Out. Makes the 
display appear 
smaller.

Delete Event. Deletes the 
selected event.

Show/Hide Channels. 
Shows or hides the 
channel icon on the 
Event button.

Undo. Undoes the change 
made to Recording Rules 
page. The Undo buffer 
has unlimited size.

Show/Hide Properties 
Dialog. Shows or 
hides the properties 
dialog of the selected 
event, action, or state.

Redo. Restores changes 
done to the Recording 
Rules page.

This display appears 
when the current 
Recording Rules 
configuration can be 
executed by the 
hardware.

Zoom In. Enlarges the 
display (see note). There 
are five zoom levels. The 
default level is the middle 
one.

This display appears 
when the current 
Recording Rules 
configuration cannot 
be executed by the 
hardware.

Apply Recording Rules to 
MPI Recording Channel

Apply Recording 
Rules to RF Recording 
Channel
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Recording Rules Page: How It Works
You can think of the Recording Rules page as a workspace for creating recording rules 
(rules that determine how the analyzer records traces). Recording rules are combinations 
of events and actions. 

In UWBTracer terms, an event and the action or actions associated with it form a rule 
state. One or more states are encapsulated in a sequence.

Note:  There can be from one to 512 states within a sequence. You can associate 
one or more events with each state, and you assign each event a different 
action or the same action.

A sequence that has only one state is called a single-state sequence. The analyzer 
continuously watches for each event in the sequence and executes the corresponding 
action if the event is detected.

A sequence that has multiple states is a multi-state sequence. The states are arranged 
in a hierarchy, with a top state and successively lower states. Only one state in a 
multi-state sequence is active at a time. The analyzer does not go to a successive state 
unless it is directed to do so by the previous state.

Sequences are described in detail in "Using Sequences" later in this chapter.

Briefly, creating a rule involves the following steps: 

Step 1 Creating Event buttons in the Available Events area.

Step 2 Drag-and-drop of Event buttons to the appropriate areas (cells) in the 
Main Display area.

Step 3 Assigning an action or actions to each Event button.
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Creating Event Buttons
To create a rule, first create one or more Event buttons. As you create Event buttons, they 
appear in the Available Events area. You then can drag-and-drop them into the Main 
Display area.

To create event buttons: 

Step 1 Click the New Event button at the left side of the toolbar to display the 
New Event pop-up menu (Figure 7.8). 

Figure 7.8 Creating a New Event

Step 2 Select an event (Figure 7.9). 

Figure 7.9 Selecting Event Type
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The event appears in the Available Events area (Figure 7.10). 

Figure 7.10Event Button Appears in Available Events Area

Dragging a Button to the Main Display Area
After you create an Event button in the Available Events area, you can drag the button to 
the Main Display area and drop it in the appropriate cell (a cell is a grayed-out rectangle 
with a dashed line around it). You can think of each cell as a target for drag-and-drop of 
an Event button.

There are two types of cell that might appear: Sequence cell and State cell. In the Main 
Display area, they are labelled as follows: 

• Sequence cell: Drag an event here to add a new sequence.
• State cell: Drag an event here to add another state.
If there currently are no events in the Main Display area, a single sequence cell appears 
at the top of the area (Figure 7.10). 
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To drag-and-drop the Event button: 

Step 1 Place the mouse cursor on the Event button in the Available Events 
area. Click the left mouse button.

Step 2 Drag the button to the cell. When the button is in the cell, a dashed 
highlight line appears around the cell (Figure 7.11). 

Figure 7.11 Drag-and-Drop Event Button to Cell

Step 3 Drop the button in the cell (release the left mouse button). The Event 
button appears in the cell (Figure 7.12). 

Figure 7.12Event Button in Cell

As shown in Figure 7.12, the default label for the first cell is "Sequence 0, State 1." As 
described later in this section, you can change that label using the Properties pop-up for 
that cell. 

As Figure 7.12 also shows, two new cells appear under the first cell. The first of these 
new cells is a state cell that allows you to create another state in rule Sequence 0 (to 
make Sequence 0 a multi-state sequence).

The second of the new cells is to create a separate sequence, which would be labelled 
Sequence 1.
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Assigning an Action
After you have dropped the Event button in a cell in the Main Display area, you can assign 
an action to the event. 

Note:  If you do not assign an action to an Event button, the analyzer ignores the 
event.

To assign an action to an Event button: 

Step 1 Right-click the Event button to display a pop-up menu (Figure 7.13). 

Figure 7.13Selecting Action From Event Button Pop-Up

Step 2 Select Specify Action, and then choose an action from the submenu. 
The menu closes, and the action is assigned (Figure 7.14). 

Figure 7.14Action Assigned to Event



UWBTracer User Manual Chapter 7: Recording Options

LeCroy Corporation  65

Note:  You can also set actions within the Properties dialog for each event. 
Double-click the Event button to open the Properties dialog, then select the 
Actions tab and set your actions.

Recording Rules Pop-Up Menus
The Recording Rules window has context-sensitive pop-up menus that are associated 
with the following types of object: cells, events, and actions.

Cell Pop-up Menu
If you click a cell in the Main Display area that has an Event button contained in it, the 
Cell pop-up menu appears (Figure 7.15). 

Figure 7.15Sequence Pop-Up Menu

The Cell pop-up menu has the following options.

• New Event: Displays the same menu that you get when you click the New Event 
button on the toolbar.

• Properties: Displays the Properties dialog for the selected cell.
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Action Pop-up Menu
If you click an Action button in the Main Display area, the Action pop-up menu appears 
(Figure 7.16). 

Figure 7.16Action Pop-Up Menu

The Action pop-up menu has the following trigger and filter options: 

• Trigger: Sets or clears Trigger action.
• Filter In: Sets or clears Filter In action. If Filter In is set, you cannot use Filter Out (it 

is disabled).
• Filter Out: Sets or clears Filter Out action. If Filter Out is set, you cannot use Filter 

In (it is disabled).

Note:  Examples that show use of filters are provided later in this chapter.



UWBTracer User Manual Chapter 7: Recording Options

LeCroy Corporation  67

Advance the Sequence: Creates an event sequence consisting of the event you clicked 
on and an event in a successive state of the sequence. A thick arrow appears from the 
selected event and points downward. 

Figure 7.17Advance the Sequence

In other words, the Advance the Sequence button is the link between two states in a 
multi-state sequence. The Advance the Sequence arrow tells the analyzer to go to the 
next state if it detects the event at the tail (origin) of the arrow.

The Action pop-up menu has the following restart and trigger options: 

• Restart the Sequence (not shown): Restarts the sequence. Note that this option is 
context-sensitive and only appears if you have created a multi-state sequence. A 
thick arrow appears from the selected event and point upward towards the first 
event in the sequence.

• Restart All: Restarts all rules in all sequences and in the global state and displays 
an arrow and a Restart All button. This action precludes selecting Advance the 
Sequence and Restart the Sequence.

• External Trigger Pulse HIGH: Sends an output signal with a Pulse High format 
through the output ports on the back of the UPAS. Pulse High is the default format. 
Pulse High causes the analyzer to transmit a 5-volt, 40-nanosecond signal.

• External Trigger Pulse LOW: Sends an output signal with a Pulse Low format 
through the output ports on the back of the UPAS. Pulse Low causes the analyzer to 
transmit a 0-volt, 40-nanosecond signal.

• External Trigger Pulse TOGGLE: Causes the analyzer to transmit a signal that 
toggles at a trigger event between a continuous 5 volt signal and a continuous 0 volt 
signal.

• Properties: Displays the Action Properties dialog for the selected action.
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Event Pop-up Menu
If you click an Event button in the Main Display area, the Event pop-up menu appears 
(Figure 7.18). 

Figure 7.18Event Pop-up Menu

The Event pop-up menu has the following options: 

• Specify Action(s): Opens the Actions submenu, allowing you to assign an action to 
the event. Options on this submenu are the same as those on the Action pop-up, 
described previously.

• Add Counter: Adds a counter to count a specified number of times the event 
occurs before the analyzer executes the corresponding action.

• Move Event to: Moves the selected event to a different position in the Recording 
Rules window.

• Copy Event to: Copies the selected event to a different position in the Recording 
Rules window.

• Delete This Event: Deletes the selected Event. Alternatively, you can use the 
Delete button on the toolbar or keyboard to delete events.

• Properties: Displays the Event Properties dialog for the selected event.
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Events and Event Properties
Recording rules are associations between events and actions. These associations 
determine how trace recording occurs.

Table 7.2 lists UWBTracer supported events.

Table 7.2 UWBTracer Events 

Event Description

MPI Bus States Occurrence of state transitions in the PHY.
WiMedia Serial Data Occurrence of serial data passed between MAC and PHY.
WiMedia Conditions Occurrence of empty frames.
Errors Occurrence of RX frame errors, aborted frames, FCS, errors, or 

length mismatch.
WiMedia Frame Occurrence of a customizable frame pattern.
WiMedia Frame Type Occurrence of specified WiMedia frame type: 

Beacon, Control, Command, Data, Aggregated Data.
WiMedia Control Frame Occurrence of specified WiMedia Control frame:

Imm-ACK, B-ACK, RTS, CTS, UDA, UDR, App Specific.
WiMedia Command Frame Occurrence of specified WiMedia Command frame:

DRP Rsv Req, DRP Rsv Resp, Probe, PTK, GTK, Range, 
App Specific.

WUSB Device Notification Occurrence of specified WUSB Device Notification:
DN_Connect, DN_Disconnect, DN_EPRdy, DN_RemoteWakeup, 
DN_MASAvailChanged, DN_Sleep, DN_Alive.

WUSB MMC Packet Occurrence of WUSB MPC packet.
WUSB Data Packet Occurrence of WUSB Data packet.
WUSB Host/Addr/Endp/Dir Occurrence of any combination of the following fields: 

HOST, ADDR, ENDP, DIR.
WUSB PID Occurrence of DATA, IDATA, HNDSHK, DN.
WUSB ACK Code Occurrence of ACK, NAK, STALL.
Breakout Board Data Occurrence of signal on breakout board data pins.
Timer Occurrence of timer expiration.
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Actions and Action Properties
Table 7.3 lists UWBTracer supported actions. 

Using a Single-State Sequence
As described previously, a sequence can be single-state or multi-state. A single-state 
sequence is a simple combination of events and actions. You cannot create looping or 
branching conditions with this type of sequence. 

A multi-state sequence allows you to branch successively to (advance to) lower states in 
the sequence or to loop to the front of the sequence (restart the sequence). 

Following are four typical examples of single-state sequences. 

Event Description

Trigger Start recording.
Filter In Include in the trace file the event specified (and no others).
Filter Out Exclude from the trace file the event specified.
Advance the Sequence Go to the next state in this sequence

(sequence in which this action is located).
Restart All Restart all sequences.
External Trigger Pulse HIGH Send HIGH pulse on external trigger output.
External Trigger Pulse LOW Send LOW pulse on external trigger output.
External Trigger Pulse TOGGLE Send HIGH-LOW pulse on external trigger output.
Properties Opens the Event Properties dialog box.
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Example 1: Creating a Simple Event Trigger
In this example, recording is triggered by detection of a WUSB ACK code.

Step 1 Click the New Event button. From the drop-down menu, select WUSB 
ACK Code > ACK (Figure 7.19). 

Figure 7.19Example 1: Creating the Event

Step 2 An ACK Event button appears in the Available Events area.

Step 3 Drag the button to the sequence cell at the top of the Main Display area.
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Step 4 Right-click the button. From the Action pop-up menu, select Trigger 
(Figure 7.20). 

Figure 7.20Example 1: Assigning the Action

Figure 7.21 shows the completed event-action sequence. 

Figure 7.21Example 1: Complete Rule
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Example 2: Creating an Event Counter
In addition to setting triggers and filters, you can set counters. A counter is an action that 
lets you set a trigger based on a count of events. To continue the previous example, for 
instance, you can create a rule that triggers on the tenth occurrence of a WUSB ACK.

Step 1 From example 1, the ACK is the first event in the state (Figure 7.21).

Step 2 Right-click the ACK event button in the cell. The Event pop-up menu 
appears.

Step 3 From the Event pop-up menu, select the Add Counter option 
(Figure 7.22). 

Figure 7.22Example 2: Adding a Counter

The Event properties dialog box appears (Figure 7.23). The set counter box is 
at the lower left (see cursor). 

Figure 7.23Example 2: Setting the Counter

Step 4 By default, the counter box is set to a value of 2. For this example, reset 
the box to 10. 
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Step 5 Close the Event properties dialog box. The counter value 10 now 
appears in the ACK Event button (Figure 7.24). The trigger occurs after 
the analyzer detects the tenth occurrence of an ACK. 

Figure 7.24Example 2: Complete Rule

Example 3: Creating an OR Condition
When you assign two or more Event buttons in state cell to the same action, the analyzer 
watches for all the events and does the action for the event that the analyzer sees first. 
Neither event has precedence over the other. There is a logical OR association among 
the events.

The following example assumes you want to trigger when the analyzer detects a WUSB 
NAK or the tenth occurrence of a WUSB ACK.

Step 1 From example 2, the ACK with counter is the first event in the state 
(Figure 7.24).

Step 2 Click the New Event button. From the drop-down menu, select WUSB 
ACK Code > NAK.

Step 3 A NAK Event button appears in the Available Events area. Drag the 
button to the first cell and drop it below the ACK button (Figure 7.25). 

Figure 7.25Example 3: Creating a Second Event
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Step 4 Right-click the NAK button. From the Action pop-up menu, select 
Trigger (Figure 7.26). 

Figure 7.26Example 3: Assigning the Action

Figure 7.27 shows the completed event-action sequence. 

Figure 7.27Example 3: Complete Rule
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Example 4: Creating an Event Filter
A filter causes the analyzer to filter in or filter out specified events from the recording. By 
default, all events are filtered in. However, you might want to preserve recording memory 
so that you can extend recording session time. To do so, you can filter out events that do 
not interest you (or filter in only those events that interest you). 

Note:  Keep in mind that when you filter out events, they are not recorded in the 
trace file. It is not the case that the events are present in the file but hidden.

The following example assumes you want recording to occur only if the analyzer detects 
an MPI error.

Step 1 Click the New Event button. From the drop-down menu, select MPI 
Errors to create an MPI Errors button in the Available Events area.

Step 2 Drag-and-drop the MPI Error button into the first cell in the Main Display 
area.

Step 3 Right-click in the Action box to the right of the MPI Error button. The 
Action pop-up menu appears (Figure 7.28). 

Figure 7.28Example 4: Assigning the Action
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Step 4 From the Action pop-up menu, select the Filter In option.

Recording is now set to only record frames with MPI errors (Figure 7.29). 

Figure 7.29Example 4: Complete Rule

Using a Multi-State Sequences
Multi-state sequences allow you to create conditions that branch down to successive 
states or loop back to the beginning of the sequence. They are more complex than 
single-state sequences but very powerful.

Example 5: Creating a Looping Sequence
Following is a typical example of a multi-state sequence. In this example, the analyzer 
waits for a WUSB Data packet (first state). When it detects a Data packet, the analyzer 
waits for a corresponding ACK packet and starts a timer (second state). 

If an ACK is received before the timer expires, the sequence restarts. If an ACK is not 
received before the timer expires, recording is triggered.

Step 1 Click the New Event button. From the drop-down menu, select WUSB 
PID > DATA to create a Data button in the Available Events area.

Step 2 Drag-and-drop the Data button into the first cell in the Main Display area.
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Step 3 Right click in the Action box to the right of the Data button. The Action 
pop-up menu appears (Figure 7.30). 

Figure 7.30Example 5: Advancing the Sequence

Step 4 From the Action pop-up, select Advance the Sequence.

Step 5 An arrow appears next to the Data button (Figure 7.31). The arrow 
points to the cell for the second state in this sequence. 

Figure 7.31Example 5: First State Complete
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Step 6 Click the New Event button. From the drop-down menu, select Timer to 
create a Timer button in the Available Events area (Figure 7.32). 

Figure 7.32Example 5: Creating an Event, Second State

Step 7 Drag-and-drop the Timer button into the second cell in the Main Display 
area (Figure 7.33). 

Figure 7.33Example 5: Dragging to the Second State Cell
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Step 8 Right-click the Timer event to open its Properties dialog box 
(Figure 7.34). 

Figure 7.34Example 5: Bringing Up the Timer Dialog Box

Step 9 In the Properties dialog box for the timer, set the timer to 100 
microseconds (Figure 7.35). 

Figure 7.35Example 5: Setting the Timer
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Step 10Click the New Event button. From the drop-down menu, select WUSB 
ACK Code > ACK to create an ACK button in the Available Events area 
(Figure 7.36). 

Figure 7.36Example 5: Creating Another Event, Second State

Step 11Drag-and-drop the ACK button into the second cell in the Main Display 
area.

Step 12Assign Restart the Sequence as the action for the ACK event. An arrow 
appears that points from the ACK back to the Data event. 

Figure 7.37Example 5: Complete Rule
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Using Independent Sequences
UWBTracer supports up to two independent sequences. By default, they are labeled 
Sequence 0 and Sequence 1. 

The two sequences operate in parallel and have no effect on each other with the following 
exception. Either of the two sequences can contain the action Restart All. This action 
restarts both sequences in the Main Display area.

Example 6: Creating Independent Sequences
The following example adds a second sequence to Example 6. The second sequence 
triggers recording if any MPI error is detected.

In this example, there are two conditions that trigger recording. The first condition is 
defined by sequence 0. The second condition is defined by sequence 1. 

Figure 7.38Example 6: Two Independent Sequences
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Chapter 8:  Decoding USB/WUSB 
Requests

8.1 Class and Vendor Definition Files
LeCroy analyzers use script files to decode class and vendor requests. The script files 
are read when the application is initialized. 

Decoding uses .dec decoder files, which describe Class or Vendor requests in a C-like 
language. The .dec files are in the Scripts directory under the application directory. Each 
.dec file stores an endpoint or request decode. When the application starts, these files 
are loaded dynamically. Subdirectories are supported.

The following .dec files are provided: 

• Hid
• Mass Storage Class
• SCSI Bulk Protocol
• UFI CBI Protocol
• PTP Still Image Class Requests
• Smart Card
• Standard Requests
• Video Class Requests
• Virtual
• Wire Adapter Class Requests and Radio Control Request
You can create your own .dec file for a Class or Vendor Request. For more information 
on the format of these Script Decoder files and the Script Decoding language, read the 
Script Decoder Manual.

8.2 Class/Vendor Decoding Options
You can permanently assign a class or vendor decoding for an address and/or endpoint 
or interface in a trace file. Once assigned, the decoding occurs automatically when you 
display transactions.
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Mapping Request Recipient to Class/Vendor Decoding
To assign a decoding group to a request recipient: 

Step 1 Click the Apply Decoding Scripts button on the Toolbar.

OR

Left-click the Control Transfer field to display the USB/WUSB Device Request 
menu.

Step 2 Select Map Request Recipients to Class/Vendor Decoding to display 
the Request Recipient and Endpoints dialog box: 

Figure 8.1 Request Recipient and Endpoints Dialog Box

The Recipient field shows all Class and Vendor Request Recipients found in the 
trace file. The display shows the Host, Address, and Type (Class or Vendor) for 
the recipient. On the right are the names of Class/Vendor Decoding groups 
currently assigned to recipients. If blank, no decoding is assigned for a recipient. 

Step 3 Select a recipient.
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Step 4 Display the Class/Vendor Decoding Groups drop-down menu. 

Figure 8.2 Class/Vendor Decoding Groups Menu

The drop-down menu lists the defined Class/Vendor request decoding groups. 
The Class/Vendor Decoding Groups are:

• No Decoding
• Mass-Strg Bulk-only Requests
• Mass-Strg Class UFI CBI Requests
• PTP Still Image Class Requests
• Standard Requests
• Video Class Requests
• Wire Adapter Radio Control Requests
• Wire Adapter Class Requests

Step 5 Select a decoding group.

OR 

Select No Decoding if you do not want any specific decoding.

Step 6 Repeat the previous steps for additional recipients.

Step 7 To retain a mapping from trace to trace DURING an application session, 
select the Keep Across Recordings checkbox.

Step 8 Click OK.
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Mapping Endpoint to Class/Vendor Decoding
To assign a Class/Vendor Endpoint decoding: 

Step 1 Click the Apply Decoding Scripts button on the Toolbar.

OR

Left-click the Bulk/Int Transfer field to display the USB/WUSB Device Request 
menu.

Step 2 Select Map Endpoint to Class/Vendor Decoding to display the 
Request Recipients and Endpoints dialog box.

Step 3 Click the Endpoints tab to display the Endpoints dialog box: 

Figure 8.3 Endpoints Dialog Box

The Endpoint field (Endp) shows all Endpoints found in the trace file. The 
displays shows the Host, Address, and Direction for the recipient. On the right 
are the names of Class/Vendor Endpoint Decoding groups currently assigned to 
endpoints. If blank, no decoding is assigned for a recipient. 

Step 4 Select an endpoint.
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Step 5 Display the Class/Vendor Endpoint Decoding drop-down menu: 

Figure 8.4 Class/Vendor Endpoint Coding Menu

The Class/Vendor Endpoint Decoding options for an OUT endpoint are: 

• No Decoding
• CCID Bulk Out Message
• Display DATA
• Mass Strg Bulk-Only SCSI Out Endp
• Mass Strg UFI_CBI Bulk Out Endp
• PTP Still Image Bulk Out
• Video Bulk Out
• Video Isoch Out
• Virtual UART
• Wire Adapter Data Transfer Out Endp
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The Class/Vendor Endpoint Decoding options an IN or Interrupt endpoint are: 

• No Decoding
• CCID Bulk In Message
• Display DATA
• HID In Endp
• Mass Strg Bulk-Only SCSI In Endp
• Mass Strg CBI Interrupt Endp
• Mass Strg UFI_CBI Bulk In Endp
• Mass Strg UFI_CBI Interrupt Endp
• PTP Still Image Bulk In
• PTP Still Image Interrupt
• Video Bulk In
• Video Interrupt
• Video Isoch In
• Virtual UART
• Wire Adapter Radio Notif Endp
• Wire Adapter Data Transfer In Endp
• Wire Adapter Notif Endp

Step 6 Select the type of decoding.

OR 

Select No Decoding if you do not want any specific decoding.

Step 7 Repeat the previous steps for any additional endpoints you would like to 
map.

Step 8 To retain a mapping from trace to trace DURING an application session, 
select the Keep Across Recordings checkbox.

Step 9 Click OK.
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Mapping Request RPipe to Class/Vendor Decoding
Before mapping Request RPipes to Class/Vendor Decoding, you must first assign the 
following endpoint decoders:

• Wire Adapter Data Out
• Wire Adapter Data In
• Wire Adapter Notif
To assign a decoding group to a Request RPipe: 

Step 1 Click the Apply Decoding Scripts button on the Toolbar.

OR

Left-click the Control Transfer field to display the USB/WUSB Device Request 
menu. 

Step 2 Select Map RPipe to Class/Vendor Decoding to display the Request 
Recipient and Endpoints dialog box.

Step 3 Click the Request RPipes tab to display the Request RPipes dialog box:  

Figure 8.5 Request RPipes Dialog Box

The Recipient field shows all Class and Vendor Request recipients found in the 
trace file. The RPipe field shows all Class and Vendor Request RPipes found in 
the trace file. The displays shows the Host, WAddress, and Type (Class or 
Vendor) for the recipient. On the right are the names of Class/Vendor Decoding 
groups currently assigned to recipients. If blank, no decoding is assigned for a 
recipient. 

Step 4 Select a recipient.

Step 5 Display the Class/Vendor Decoding Groups drop-down menu. The 
Class/Vendor Decoding Groups are the same as for Request 
Recipients.
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Step 6 Select a decoding group.

OR 

Select No Decoding if you do not want any specific decoding.

Step 7 Repeat the previous steps for additional recipients.

Step 8 To retain a mapping from trace to trace DURING an application session, 
select the Keep Across Recordings checkbox.

Step 9 Click OK.

Mapping Endpoint RPipe to Class/Vendor Decoding
To assign a Class/Vendor Endpoint RPipes decoding: 

Step 1 Click the Apply Decoding Scripts button on the Toolbar.

OR

Left-click the Bulk/Int Transfer field to display the USB/WUSB Device Request 
menu.

Step 2 Select Map Endpoint RPipe to Class/Vendor Decoding to display the 
Request Recipients and Endpoints dialog box.

Step 3 Click the Endpoint RPipes tab to display the Endpoint RPipes dialog 
box: 

Figure 8.6 Endpoint RPipes Dialog Box

The RPipe field shows all RPipes found in the trace file. The displays shows the 
Host, Address, and Direction for the recipient. On the right are the names of 
Class/Vendor Endpoint Decoding groups currently assigned to endpoints. If 
blank, no decoding is assigned for a recipient.

Step 4 Select an endpoint RPipe.
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Step 5 Display the Class/Vendor Endpoint Decoding drop-down menu. The 
Class/Vendor Endpoint Decoding options are the same as for Endpoints.

Step 6 Select the type of decoding.

OR 

Select No Decoding if you do not want any specific decoding.

Step 7 Repeat the previous steps for any additional RPipes you would like to 
map.

Step 8 To retain a mapping from trace to trace DURING an application session, 
select the Keep Across Recordings checkbox.

Step 9 Click OK.

8.3 General Options
Decoding uses control transfers called USB/WUSB Device Requests. Device Requests 
depend on the Device Class and Vendor specifications.

Decoding USB/WUSB Device Requests
To decode a USB/WUSB Device Request: 

Step 1 Left-click the Control Transfer field of the USB/WUSB Device Request 
to display the USB/WUSB Device Request menu: 

Figure 8.7 UWB Device Request menu

Note The menus shown in this section are context-sensitive. You may see 
slightly different menus. 

Step 2 To refresh decoding, click Refresh Decoding for this Trace File. Use 
this option to reanalyze all transactions.

Step 3 To move to the next Control Transfer field, click Find Next Occurrence.
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Step 4 To expand data fields for one row, use Expand WUSB Trans Out, 
Expand WUSB Trans In, Expand This WUSB Transfer, or Expand 
WUSB Xfer.

Step 5 To collapse data fields for one row, use Collapse WUSB Trans Out, 
Collapse WUSB Trans In, Collapse This WUSB Transfer, or 
Collapse WUSB Xfer.

Step 6 To expand all data fields of the same type, use Expand All WUSB 
Trans Out Fields, Expand All WUSB Trans In Fields, Expand All 
WUSB Transfers, or Expand All WUSB Xfer.

Step 7 To collapse all data fields of the same type, use Collapse All WUSB 
Trans Out Fields, Collapse All WUSB Trans In Fields, Collapse All 
WUSB Transfers, or Collapse All WUSB Xfer.

Note: You can also change the format, color, and hidden status of fields, using 
the same methods as in Display Options. (See Chapter 6, Display 
Options.)
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Decoding Standard Requests
To decode a standard request: 

Step 1 From the USB/WUSB Device Request menu, select Decode Standard 
Request to display the View Fields for Standard Request text box: 

Figure 8.8 Standard Request Text Box

Step 2 To find a word in the text box, click the Find button. Enter the word in the 
Find What field. To use a case-sensitive search, check Match Case. To 
find only the exact word, check Match Whole Word Only. You can 
search Up or Down. To search, click Find Next.

Step 3 To save the View Fields text box as an HTML file, click the Save As 
button, enter a file name in the Save As dialog box, then click Save.

Step 4 To view the previous or next Transfer Control field request of the same 
request type, click Previous or Next.

The View Fields for Standard Request dialog box displays field definitions and values of 
the Standard Request. 
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For field definitions, please refer to the Universal Serial Bus Specification, version 2.0. 
The USB specification is available from the USB Implementers Forum (USB-IF) at: 

Decoding Class Requests
Examples of a class request are Mass-Strg Class UFI CBI Requests, 
PTP Still Image Class Requests, Video Class Requests, and Wire Adapter Class 
Requests. 

To decode a class request: 

Step 1 From the USB/WUSB Device Request menu, select 
Decode ... Request to display the View Fields for ... Class Requests 
text box.

Figure 8.9 shows a Wire Adapter Class Requests decoding:

Figure 8.9 View Fields for Wire Adapter Class Requests Request Text Box

USB Implementers Forum
1730 SW Skyline Blvd. 
Suite 203
Portland, OR 97221

Tel: +1/503.296.9892
Fax: +1/503.297.1090
Web: http://www.usb.org/
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Figure 8.10 shows a Mass Storage Bulk-only Request: 

Figure 8.10View Fields for Mass Storage Bulk-only Class Requests 
Text Box

Decoding Vendor Requests
To decode a vendor request: 

• Select Decode ... Request to display the View Fields for ... Vendor Requests text 
box.

An example of a vendor request is UWBTracer™ Command Set. 

Decoding Undefined USB/WUSB Device Requests
A Decoding Request may not belong to any of the defined decoding groups (Standard, 
Class, or Vendor).

Decoding using Endpoint Information
To decode using the endpoint information: 

Step 1 Left-click the Bulk/Int Transfer field to display the Bulk/Int Transfer 
(IN/OUT transaction with data) menu.

Step 2 Select Decode as ... Endp to open a View Fields for ... Endp text box.
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Figure 8.11 shows a Wire Adapter Data Transfer In Endp decoding:  

Figure 8.11 View Fields for Wire Adapter Data Transfer In Endp Text Box

Figure 8.12 shows a Wire Adapter Data Transfer Out Endp decoding: 

Figure 8.12View Fields for Wire Adapter Data Transfer Out Endp Text Box
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Figure 8.13 shows a Wire Adapter Data Transfer Out Endp decoding: 

Figure 8.13View Fields for Wire Adapter Data Transfer Out Endp Text Box

Figure 8.14 shows a Wire Adapter Notif Endp decoding: 

Figure 8.14View Fields for Wire Adapter Notif  Endp Text Box

Figure 8.15 shows a Mass Storage Bulk-only SCSI In Endpoint decoding: 

Figure 8.15View Fields for Mass Storage Bulk-only SCSI In Endp Text Box
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Figure 8.16 shows a Mass Storage Bulk-only SCSI Out Endpoint: 

Figure 8.16View Fields for Mass Storage Bulk-only SCSI Out Endp 
Text Box

Changing the Layout of Decode Requests
In the View ... Fields windows, the Decoding Information and the Descriptor information 
blocks (following the Request Summary information) have the following columns:

• Field: such as bRequest, wValue, wIndex, bLength, bDescriptorType, wTotalLength
• Length in bits
• Offset in bits
• Decoded: hex value typically equal to Hex Value
• Hex Value: hex value typically equal to Decoded
• Description: short description of field
To change the layout of decode requests display: 
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Step 1 Click Layout to display the View ... Fields Dialog Layout dialog box: 

Figure 8.17View WUSB Xfer Fields Dialog Layout Dialog Box

Step 2 To display the available columns of data, use the checkboxes for 
Length, Offset, Decoded, Hex Value, and Description.

You can Check All or Uncheck All.

Step 3 To show only the fields of Collapsed mode, check Show only fields 
specified for view in collapsed mode.

Step 4 To retain settings for future viewing of Decode Request fields, check 
Use these settings when View Fields dialog opens.
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Chapter 9:  Reports
Reports assist you in analyzing traffic recorded by the analyzer. The available reports 
are: 

• File Information: To view general information about the trace file.
• Error Summary: To view a count of errors in a trace file.
• Timing Calculations: To view timing measured between two markers or counters 

set within the trace file.
• Traffic Summary: To view a summary of protocol-related information in the trace 

file summary information about a selected group of items in the trace file (such as a 
count of particular frame or packet types).

Reports are available from the Report menu and from buttons on the Tool bar. 

Figure 9.1 Report Menu
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9.1 File Information
To view general trace information, such as time a trace was made, version of the analyzer 
firmware, and BusEngine™ used, select Report > File Information to display the File 
Information window (Figure 9.2).

Figure 9.2 File Information Window
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To view the Recording Options settings, select the Open Recording Options in a dialog 
link to display the Recording Options window.

9.2 Traffic Summary
To view a summary of protocol-related information, select Report > Traffic Summary to 
display the Traffic Summary window (Figure 9.3).

In the left pane, select or expand a report: MPI Frames, WUSB Packets, WUSB 
Transactions, WUSB Transfers, or Errors to display the items and counts of the report in 
the right pane. 

Figure 9.3 Traffic Summary Window

Traffic Summary Buttons
The Traffic Summary toolbar provides a shortcut to commands that control the traffic 
summary (Figure 9.4). 

Figure 9.4 Traffic Summary Toolbar

Table 9.1 describes the Traffic Summary buttons.

Table 9.1Traffic Summary Buttons
Save. Saves the traffic summary to 
a file in HTML format.

Text. Displays the traffic summary in 
text format.

Email/Send. Sends the traffic 
summary in HTML format via an 
email.

Options/View. Opens a menu that 
allows you to set the way trace file 
items are counted for the traffic 
summary.

Print. Prints the traffic summary.
Select Range. Sets a range of items 
to be counted in the trace file.
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Using the Traffic Summary
To use the traffic summary window, you need to know how to select the items for which 
you want a summary, to set a range for the summary, and to use navigational features.

Selecting Traffic Summary Items
As described, you use the left pane of the Traffic Summary window to select the item for 
which you want to show a summary in the right pane.

For example, suppose you want to show the count of all MPI Frames in the trace. To do 
so, select MPI frames in the left pane (Figure 9.5). A count of the number of MPI frames 
appears in the right pane. In this example, there are three MPI Control frames and three 
MPI Data frames. 

Figure 9.5 Selecting an Item for the Traffic Summary

You can select multiple items in the left pane, each resulting in a separate summary in 
the right pane (the summaries follow each other sequentially) (Figure 9.6). To select 
more than one item, hold down the CTRL key as you select items in the left pane. 

Figure 9.6 Selecting Multiple Items for the Traffic Summary
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Setting Traffic Summary Display Options
You can control the appearance of the traffic summary display using the Options button 
on the Traffic Summary tool bar. When you click the button, the Options drop-down menu 
appears (Figure 9.7). 

Figure 9.7 Traffic Summary Options Menu

Grid Lines: Enables/disables grid lines to the display.

Row Selection: Enables/disables row highlighting in the right pane.

Tight Columns: Enables/disables narrow columns in the display.

Event Navigation: Displays a menu that allows you to set parameters for using traffic 
summary to navigate in the trace (trace navigation is described later in this section) 
(Figure 9.8). 

Figure 9.8 Event Navigation Submenu

In the Event Navigation menu, the Skip hidden items option means you cannot navigate 
to hidden items in the trace. Show hidden items means if you navigate to a hidden item, 
the item is shown in the trace. Prompt each time means you can navigate to a hidden 
item, but UWBTracer™ prompts you to indicate whether or not you want the item to 
appear in the trace.
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Setting Traffic Summary Range
You can select a range within the trace file for which items are displayed in the traffic 
summary. All occurrences of the item outside of the range are not included in the 
summary. You can set the range with respect to particular frame or packet types. Your 
choice of these types is context-sensitive and is determined by the current trace decode 
level (MPI trace level view, WUSB packet level view, and so on).

In the following example, suppose you have trace decode level set to WUSB packet level 
view and suppose the trace contains six MPI frames. 

To collect statistics from the third through fifth MPI frames (inclusive):

Step 1 With the trace file open, select Traffic Summary from the Report menu 
(or click the Traffic Summary button on the Main tool bar). The Traffic 
Summary window appears.

Step 2 Select MPI frames in the left pane of the Traffic Summary window. The 
summary for MPI frames appears in the right pane.

Step 3 Click the Select Range button on the Traffic Summary tool bar 
(Figure 9.9). 

Figure 9.9 Selecting Traffic Summary Range

Step 4 The Select Range dialog box appears (Figure 9.10). 

Figure 9.10Select Range Dialog Box
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Step 5 In the Select Range dialog box, select Frame as the protocol unit. Enter 
3 as the start point of the range (Figure 9.11). 

Figure 9.11 Setting Range to Start on Third Frame

Step 6 The Traffic Summary window now shows statistics for Frame 3 through 
Frame 1472 of the trace (Figure 9.12). 

Figure 9.12Traffic Summary for Three MPI Frames
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Using the Display to Navigate Within the Trace File
You can use the Traffic Summary window to navigate to a specific frame or packet in the 
trace file. For example, suppose you want to go to the second MPI Data frame. 

To navigate:

Step 1 With the trace file open, select Traffic Summary from the Report menu 
(or click the Traffic Summary button on the Main tool bar). The Traffic 
Summary window appears.

Step 2 Select MPI frames in the left pane of the Traffic Summary window. The 
summary for MPI frames appears in the right pane.

Note:  In this example, the trace contains three MPI Control frames and three MPI 
Data frames.

Click the count in the total column for Data frames (Figure 9.13). 

Figure 9.13Selecting the Row for Data Frames
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Step 3 The Go box becomes active at the top of the right pane (Figure 9.14). By 
default, it is set at the first MPI Data frame (MPI 1), shown at the top in 
the trace. 

Figure 9.14First MPI Data Frame at Top of Display

Step 4 In the Go box, enter 2 to indicate that you want to go to the second MPI 
Data frame in the trace (Figure 9.15). 

Figure 9.15Set Go Box to Second MPI Data Frame

Go
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The trace display adjusts so that the second MPI Data frame appears at the top of the 
display (MPI 3), shown at the top of the trace (Figure 9.16). 

Figure 9.16Set Go Box to Second MPI Data Frame 

9.3 Error Summary
To view a count of errors, select Report > Error Summary to display the Traffic 
Summary window (Figure 9.17). 

Figure 9.17Error Summary Display

The right pane display the error counts.

Note:  You cannot change the types of errors included in the summary.
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9.4 Timing Calculations
The timing calculator measures timing between any two specified frames. To run the 
Timing Calculator:

Step 1 From the Report menu, select Timing Calculations.

Step 2 Select the range From MPI To MPI, and then click the Calculate button 
to display the results. 

Figure 9.18Timing and Bus Usage Calculator
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9.5 Real-Time Statistics
To display a summary of the occurrence of various types of protocol units in a trace file, 
select Report > Traffic Summary from the Report menu. A Traffic Summary window 
appears, showing the traffic data (Figure 9.3).

To display information on links activity in real-time, select Report > Real-Time Statistics 
from the Report menu. The Real-Time Statistics window shows frames, errors, and 
events occurrences (Figure 9.19). 

Figure 9.19Real-Time Statistics window

The window has two areas:

• Graph Area (left side of window): Provides graphs that show occurrences of partic-
ular frames, errors, and events. 

• General Statistics Area (right side of window): Provides displays that show signal 
strength, link quality, number of frames, and signal status. All data that is displayed 
is calculated as averages over a sampling period.

Changing Devices
The window can display information from multiple analyzer devices. You toggle displays 
for each device by clicking on tabs in the General Statistics area. For example, as shown 
in Figure 10.19, the SN566 tab is selected. The display currently shows information for 
the SN566 device. To switch the display to information for the SN567 device, click the 
SN567 tab. 
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Changing Channels
The window can display information from the MPI or RF channel. In the Channel field at 
the top of a device tab, select MPI or RF from the drop-down list. Figure 9.19 shows the 
MPI channel of the SN566 device.

Tool Bar
The Real-Time Statistics window tool bar provides quick access to key functions of the 
window (Figure 9.20). 

Figure 9.20Real-Time Statistics Tool Bar

Table 9.2 describes the Real-Time Statistics buttons.

Table 9.2Real-Time Statistics Toolbar Buttons

Save Vertical Zoom out

E-mail "Click and Drag" Zoom Area

Print Synchronize Graph Areas

Full Screen Graph Areas

View Settings Start Real-Time Statistics

Horizontal Zoom in Stop Real-Time Statistics

Horizontal Zoom out Reset Graphs and Counters Display

Vertical Zoom in
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Graph Area
The graph area displays two graphs: occurrences of frames and occurrences of errors. 
You can set the properties of each through a Graph Area Properties dialog box. To bring 
up the dialog box for either of the two graphs:

Step 1 Put the mouse cursor in the area of the graph and click the right mouse 
button. 

Step 2 A pop-up menu appears (Figure 9.21).

Figure 9.21Real-Time Graphs Pop-Up Menu

Step 3 Click Properties to bring up the Graph Area Properties dialog box for 
that graph.

Graph Properties for Frame Occurrences
Figure 9.22 shows the Graph Properties dialog box for the Frame Occurrences graph. 
You can select from a variety of graphs that show statistics about different frame types.

The left side of the dialog box shows a list of graphs associated with each analyzer in the 
analyzer network (SN566, SN567 and so on). When you add a new analyzer to the 
analyzer network, a new set of graphs is added to the list. 

Figure 9.22Graph Area Properties for Frames
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Graph Properties for Error Occurrences
Figure 9.23 shows the Graph Area Properties dialog box for Error Occurrences graph. 
There are two types of error graphs: Device-specific Errors and General Errors.

Device-specific Errors
Device-specific Errors can be associated with specific UWB devices. 
The Device-specific Errors that you can monitor are:

• PHY Payload Error
• PHY Unsupported Rate

General Errors
General Errors cannot be associated with specific UWB devices. Currently, there is one 
General Error that you can monitor through this graph:

• Header Error 

Figure 9.23Graph Area Properties for Error Occurrences
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General Statistics Area
The right side of the Real-Time Statistics window shows the General Statistics area. The 
following figure (Figure 9.24) shows MPI information. 

Figure 9.24Real-Time Statistics Window: General Statistics Area for MPI 
Information

It has the following displays: 

• Number of analyzer devices connected: Each one has a tab in the display.
• Channel: MPI or RF
• Accumulators: Running count of total frames displayed during the statistics collec-

tion period.
• RSSI By Device: Histogram showing received signal strength for UWB devices.
• LQI By Device: Histogram showing link quality for up to eight UWB devices.
• MPI Wire Activity: Signal state on the MPI bus:

• Purple bar: Signal high
• Green bar: Signal low
• Red arrow: Signal toggled at least once during latest signal period
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The following figure (Figure 9.25) shows MPI information. 

Figure 9.25Real-Time Statistics Window: General Statistics Area for RF 
Information

It has the following displays: 

• Number of analyzer devices connected: Each one has a tab in the display.
• Channel: MPI or RF
• Accumulators: Running count of total frames displayed during the statistics collec-

tion period.
• RSSI By Device: Histogram showing received signal strength for UWB devices.
• LQI By Device: Histogram showing link quality for up to eight UWB devices.
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9.6 Bus Utilization
The Bus Utilization window displays information on bandwidth use for the the recording 
channels.

To open the Bus Utilization window, select Report > Bus Utilization or

click the button. 

Figure 9.26Bus Utilization Window
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Bus Utilization Buttons 
The Bus Utilization window has a row of buttons for changing the format of the displayed 
data and for exporting data:

Figure 9.27Bus Utilization Buttons

The buttons have the following functions: 

Save As - Saves the 
graphs as a bitmap file 
(*.bmp)

Vertical zoom in

Email - Creates an email 
with a *.bmp file 
attachment of the graphs

Vertical zoom out

Print
"Click and Drag" zoom mode - Click 
diagonally to select and zoom in on part 
of the graph

Full screen Select Range

View settings - opens a 
sub-menu with options for 
formatting the display. 
See “View Settings Menu” 
below.

Synchronize graph areas - If two or more 
graphs are displayed, this button 
synchronizes the graphs to one another. 
Once synchronized, the positioning 
slider of one graph moves the other 
graphs.

Horizontal zoom in
Graph Areas - Presents options for 
displaying additional graphs of data 
lengths, packet lengths, and percentage 
of bus utilized.

Horizontal zoom out
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View Settings Menu
Clicking the View settings button causes a menu to open with options for 
formatting the display. 

Figure 9.28View Options: View Settings Menu

• Orient Horizontally: changes the orientation of bus usage to horizontal. After 
selecting this option, the menu has Orient Vertically.

• Tile Vertically: tiles the two graphs vertically (i.e., side by side). After selecting this 
option, the menu has Tile Horizontally.

• Show Markers: Places "tick" marks along the x axis of each graph.
• Show Plumb Line
• Status: Opens a submenu with the following options:

• Bar: Displays a status bar at bottom of graph.
• Tooltip: Causes a tooltip to appear if you position your mouse pointer over 

part of the graph and leave it there for a couple of seconds.
• None: Turns off tooltips and the status bar.

• Grid Lines: Opens a submenu with the following options:
• Both Axes: Displays both X and Y axis gridlines
• X Axis: Displays X axis gridlines
• Y Axis: Display Y axis gridlines
• No Grid: Turns off gridlines

• Grid on Top: Moves the grid lines above the graph.
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• Fonts and Colors - Opens a dialog box for setting the colors and fonts used in the 
graphs:

Figure 9.29View Options: Fonts and Colors

Graph Areas Menu
The Graph Areas menu allows you to view different information types in the Bus 
Utilization window. 

Step 1 Click the button to display the Graph Areas menu: 

Figure 9.30Graph Areas Menu

Step 2 Select the data you want to appear in the Graph Areas window: Packet 
length, Data length, RSSI & LQI, and/or Data Throughput. 
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To change the properties in the Bus Utilizations graph: 

Step 1 In the Graph Areas menu, click New to display the Graph Area 
Properties dialog box. 

Figure 9.31Graph Area Properties Dialog Box

Step 2 Select the graph or click New to make a new graph.

Step 3 Enter a graph title in the Title field.

Step 4 Select the Type: Packet length, Data Payload length, RSSI, LQI, or Data 
Throughput.

Step 5 Select the Appearance: single or multiple color bars or lines, or thick 
lines. If you selected bars, select the Color.

Step 6 Click OK.

9.7 Device List
The Device List window lists the DUTs, active devices, archive devices, and 
wireless USB by DUTs, Type, EUI-48, Address, Alias, Last Updated, and User Notes. 

Figure 9.32Device List Window

You can display the list in HTML View or Grid View using the button. 

If the Device List is displayed in HTML View, you can print the list. (Do not print from 
Grid View.)

You can import a UWB Device List Saved File (extension .dl). 
You can save the Device List as an HTML file.
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Add Device
To add device data: 

Step 1 In the Device List window, click the Add New Device  button to 
display the Add New Device dialog box at the General Settings tab: 

Figure 9.33Add New Device Dialog Box General Settings Tab

Step 2 In the Add New Device dialog box, select the Device Type as 
WiMedia Device, Wireless USB Host, or Wireless USB Device. 

Step 3 Enter the EUI-48 in hexadecimal. 

Step 4 Enter the Device Address in hexadecimal. 

Step 5 (optional) Enter an Alias. 

Step 6 (optional) Enter any User Notes. 

Step 7 (optional) Select the DUTs checkbox if applicable. 
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Step 8 For a Wireless USB Host device, select the 
Device Type Specific Settings tab. 

Figure 9.34Add New Device Dialog Box Device Type Specific Settings Tab 
for Wireless USB Host

Enter the CHID (host ID) in hexadecimal.

Click OK to return to the Device Type Specific Settings tab.
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Step 9 For a Wireless USB Device device, select the 
Device Type Specific Settings tab. 

Figure 9.35Add New Device Dialog Box Device Type Specific Settings Tab 
for Wireless USB Device 

Enter the CDID (device ID) in hexadecimal.

Click OK to return to the Device Type Specific Settings tab.
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Edit Device
To edit a device, select the device in the Device List, then click the Edit Device  
button. 

Figure 9.36Edit Device Dialog Box

You can edit only the Alias, User Notes, and DUTs checkbox of the device data in the 
Edit Device dialog box General Settings tab. 

You can edit only the list of hosts or devices in the Device Type Specific Settings tab.

Delete Device
To delete a device, select the row in the Device List, then click the Delete Device  
button.
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Chapter 10:  Updates and Licensing
This chapter describes how to update to UWBTracer™ software and how to obtain a 
software license key from LeCroy. 

10.1 Updates Overview
From time to time as modifications are made to the UWBTracer Analyzer, it may become 
necessary to update the UWBTracer software. You can obtain new software from the 
LeCroy website: 

www.LeCroy.com
When you download new UWBTracer software, the most recent firmware and 
BusEngine™ files are included in the software package. After software installation, you 
can compare the firmware and BusEngine version numbers against what is currently 
loaded on the analyzer. If those files do not match, you can download the latest versions 
using the manual or automatic process described later in this chapter.

Note:  LeCroy analyzers include a Three-Year Investment Protection Agreement 
that entitles users to new software during that period. To update software 
after that period, you must renew the LeCroy Maintenance Agreement. 
Contact LeCroy for details.
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10.2 Software, Firmware, and BusEngine Versions
The Readme file on the installation CD and on the installed directory on your hard drive 
gives last-minute information about the current release. As mentioned, the software 
package for each release includes the most recent downloadable images of the firmware 
and the BusEngine. 

Once the UWBTracer Analyzer has completed the self diagnostics and is connected to 
the PC, you can check the latest version of the software and BusEngine.

To check information about the current software:

• Select About UWBTracer… from the Help menu to display the About UWBTracer 
window (Figure 10.1). 

Figure 10.1About UWBTracer Window

About UWBTracer details revisions of the following software and hardware:

• UWBTracer Software Version, Build Number
• UWBTracer Firmware Version
• BusEngine Version, Build Number
• Unit Serial Number

Note:  When contacting LeCroy for technical support, please have available all the 
revisions reported in the About UWBTracer window.
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10.3 Software Updates
When a new software release is available, it is posted on the Support page of the LeCroy 
website at www.LeCroy.com/support.html.
To update the software: 

Step 1 Find the latest released software version on the LeCroy website under 
Support.
If you are running the latest version of the software, no further action is needed. 
If you are not running the latest version, continue to Step 2.

Step 2 Download the Zip file from the website.

Step 3 Unzip the files into your choice of directory.

Step 4 Click Start, then Run, and browse to where you unzipped the files.

Step 5 Select the program named Setup and click Open.

Step 6 Click OK to run the Setup and begin the installation.

Step 7 Follow the on-screen instructions to complete the installation.

Step 8 Read the Readme file for important information on changes in the 
release.
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10.4 BusEngine and Firmware Updates
Often you need to update BusEngine and firmware files when you update the UWBTracer 
software. The software Readme file indicates if BusEngine and/or firmware updates are 
necessary.

Note:  Within a new software release, it might also be necessary to update the 
BusEngine hardware of the analyzer. The Readme file lets you know if this 
is necessary. 

Automatic Update of BusEngine and Firmware
When you update UWBTracer software, the new version might not match (be compatible 
with) the BusEngine and firmware currently installed on the analyzer. As the software is 
loaded, it determines if there is a mismatch. If so, the software initiates automatic update 
of the firmware and BusEngine.

A dialog box appears to confirm that you want to proceed with the update. If so, click OK. 
The update is executed.

Manual Update of BusEngine and Firmware
You also can manually load firmware and BusEngine files using the Update BE/FW 
command on the Setup menu. 

To update manually: 

Step 1 From the Setup menu, select Update BE/FW to display the 
Analyzer Setup dialog box: 

The Entity can be Firmware, BusEngine, and Plugin Init (PHY Initialization data). 
The Current Version, Required Version, and Status are listed. 

Figure 10.2Analyzer Setup Dialog Box
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Step 2 Select whether to update Firmware, BusEngine, and/or Plugin Init, then 
click the Update button to display a dialog box.

Step 3 Click OK to confirm that you want to proceed with the update. The 
update is executed.

Update of Other Files
For the UWBTracer software, you may need to update the PHY initialization data. 

To update manually, follow the instructions for "Manual Update of BusEngine and 
Firmware" on this page.

To update automatically, follow the instructions for "Automatic Update of BusEngine and 
Firmware" on this page.

10.5 License Information
You can view license information for UWBTracer by selecting Display License 
Information from the Help menu. The License window indicates the maintenance 
expiration data for UWBTracer. It also provides a list of the named features supported by 
the current software version. 

Named features enabled on your PC are indicated by Yes in the Purchased column. 
Named features that are not enabled on your PC are indicated by No in the Purchased 
column. Whether or not named features are enabled depends on the license key stored 
in your analyzer. 

Figure 10.3License Window
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10.6 Updating the Software License
A current license agreement with LeCroy entitles the analyzer owner to continued 
technical support and access to software updates as they are published on the LeCroy 
website. 

If your license expires, you must obtain a license key from LeCroy (refer to the contact 
information at the back of this manual.) 

After you obtain a license key, follow these steps to install it:

Step 1 From the Help menu, select Update License. The Update License 
dialog box appears. 

Step 2 Enter the path and filename for the license key or use the Browse button 
to navigate to the directory that contains the license key. 

Step 3 Select the *.lic file, and then click Update Device.
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Appendix A:  External Connectors
This chapter describes the Trigger Cable TRIG-IN/TRIG-OUT BNC Y-cable and 
Synchronization Cable included with the UWBTracer™ system and the External Data 
connector and SYNC IN and SYNC OUT connectors located on the UWBTracer rear 
panel.

A.1 External Triggering Connector
With each analyzer, LeCroy includes a TRIG-IN/TRIG-OUT BNC Y-cable (Figure A.1) 
that allows you to export a trigger signal to, and receive a trigger signal from, external 
equipment. 

Figure A.1 Trigger Cable

The Trigger Cable connects to the EXT DATA connector (Figure A.2) located on the 
UWBTracer rear panel.  

Figure A.2 EXT DATA Connector
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A.2 SYNC Connectors
The Synchronization Cable (Figure A.3) connects to the SYNC IN and SYNC OUT 
connectors located on the UWBTracer rear panel (Figure A.2). 

Figure A.3 Synchronization Cable
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Appendix B:  MPI
B.1 Cable Adapter Pin Assignments

Table B.1 and Table B.2 show connector pin assignments for the 68-pin and 40-pin probe 
cables. 

Figure B.1 UWBTracer Device Connections



Appendix B: MPI UWBTracer User Manual

136 LeCroy Corporation

Table B.1 Adapter Pin Assignments: 68-Pin Probe Cable
PIN# Definition PIN# Definition

A1 N/C B1 N/C

A2 GND B2 GND

A3 DATA[0] B3 PHY_RESET

A4 GND B4 GND

A5 DATA[1] B5 N/C

A6 GND B6 GND

A7 DATA[2] B7 MCTL

A8 GND B8 GND

A9 DATA[3] B9 SERIAL_DATA

A10 GND B10 GND

A11 DATA[4] B11 CCA_STATUS

A12 GND B12 GND

A13 DATA[5] B13 CCA_REQ

A14 GND B14 GND

A15 DATA[6] B15 N/C

A16 GND B16 GND

A17 DATA[7] B17 N/C

A18 GND B18 GND

A19 PCLK B19 N/C

A20 GND B20 GND

A21 N/C B21 N/C

A22 GND B22 GND

A23 TX_EN B23 N/C

A24 GND B24 GND

A25 RX_EN B25 N/C

A26 GND B26 GND

A27 FSYNC B27 N/C

A28 GND B28 GND

A29 PHY_ACTIVE B29 N/C

A30 GND B30 GND

A31 DATA_EN B31 +5V

A32 GND B32 GND

A33 EOF B33 +V5

A34 GND B34 GND
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Table B.2 Adapter Pin Assignments: 40-Pin Probe Cable

B.2 Input Load of UWBTracer MPI
Each MPI signal pin has a 220 ohm tapping resistor followed by a CMOS buffer with 10pF 
of input capacitance. The resistor and buffer are within 2 inches of the connector on the 
Cable Adapter or Board Adapter. 

PHY MPI pin ------------------ Connector pin

|

|

|------ Resistor ------ Buffer

|

|
MAC MPI pin ------------------ Connector pin

PIN# FUNCTION PIN# FUNCTION
1 RESET 2 GND

3 DATA0 4 NC

5 DATA1 6 PWR

7 DATA2 8 PWR

9 DATA3 10 PWR

11 DATA4 12 PWR

13 DATA5 14 PWR

15 DATA6 16 PWR

17 DATA7 18 NC

19 GND 20 KEY

21 PCLK 22 GND

23 TX_EN 24 GND

25 RX_EN 26 GND

27 PHY_ACT 28 NC

29 DATA_EN 30 GND

31 CCA_ST 32 GND

33 SE_DAT 34 GND

35 STOP_C 36 GND

37 RSVD1 38 GND

39 RSVD2 40 GND
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Appendix C:  Specifications
The following specifications describe a combined CATC 5K Analyzer and UWB Analyzer 
Plug-in.

Package 

Power Requirements
12 VDC, 60 W maximum 

Environmental Conditions 

Dimensions CATC 5K:
9.8 x 6.5 x 2.0 inches (24.9 x 16.5 x 5.1 cm)
UWB Analyzer Plug-in: 
4.0 x 5.0 x 1.3 inches (10.2 x 12.7 x 3.3 cm)

Connectors CATC 5K:
12 VDC power connection
External I/O and trigger connection (Mini DIN-9)
External Sync IN connection (Mini DIN-4)
External Sync OUT connection (Mini DIN-4)
Antenna RF SMA Connector
PC connection (USB2.0, type "B")
UWB Analyzer Plug-in:
MPI Adapter port

Weight CATC 5K:
Approximately 2 lbs. 9 oz. (1.2 kg)
UWB Analyzer Plug-in:
Approximately 3 oz. (0.1 kg)

Operating Range 0 to 40°C (32 to 104°F)

Storage Range -20 to 80°C (-4 to 176°F)

Humidity 10 to 90%, non-condensing
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How to Contact LeCroy

Limited Hardware Warranty
So long as you or your authorized representative ("you" or 
"your"), fully complete and return the registration card 
provided with the applicable hardware product or peripheral 
hardware products (each a "Product") within fifteen days of 
the date of receipt from LeCroy or one of its authorized 
representatives, LeCroy warrants that the Product will be free from defects in materials 
and workmanship for a period of three years (the "Warranty Period"). You may also 
complete your registration form via the internet by visiting 
http://www.catc.com/support/register/. The Warranty Period commences on the earlier of 
the date of delivery by LeCroy of a Product to a common carrier for shipment to you or to 
LeCroy's authorized representative from whom you purchase the Product.

What this Warranty Does Not Cover
This warranty does not cover damage due to external causes including accident, damage 
during shipment after delivery to a common carrier by LeCroy, abuse, misuse, problems 
with electrical power, including power surges and outages, servicing not authorized by 
LeCroy, usage or operation not in accordance with Product instructions, failure to perform 
required preventive maintenance, software related problems (whether or not provided by 
LeCroy), problems caused by use of accessories, parts or components not supplied by 
LeCroy, Products that have been modified or altered by someone other than LeCroy, 
Products with missing or altered service tags or serial numbers, and Products for which 
LeCroy has not received payment in full.

Coverage During Warranty Period
During the Warranty Period, LeCroy or its authorized representatives will repair or 
replace Products, at LeCroy's sole discretion, covered under this limited warranty that are 
returned directly to LeCroy's facility or through LeCroy's authorized representatives.

Type of Service Contact
Call for technical support… US and Canada: 1 (800) 909-2282

Worldwide: 1 (408) 727-6600
Fax your questions… Worldwide: 1 (408) 727-6622
Write a letter… LeCroy

Customer Support
3385 Scott Blvd.
Santa Clara, CA 95054

Send e-mail… support@catc.com
Visit LeCroy’s web site… http://www.lecroy.com/
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How to Obtain Warranty Service
To request warranty service, you must complete and return the registration card or 
register via the internet within the fifteen day period described above and report your 
covered warranty claim by contacting LeCroy Technical Support or its authorized 
representative. 

You can reach LeCroy Technical Support at 800-909-7112 or via email at 
support@catc.com. You may also refer to the LeCroy website at http://www.lecroy.com 
for more information on how to contact an authorized representative in your region. If 
warranty service is required, LeCroy or its authorized representative will issue a Return 
Material Authorization Number. You must ship the Product back to LeCroy or its 
authorized representative, in its original or equivalent packaging, prepay shipping 
charges, and insure the shipment or accept the risk of loss or damage during shipment. 
LeCroy must receive the Product prior to expiration of the Warranty Period for the 
repair(s) to be covered. LeCroy or its authorized representative will thereafter ship the 
repaired or replacement Product to you freight prepaid by LeCroy if you are located in the 
continental United States. Shipments made outside the continental United States will be 
sent freight collect.

Please remove any peripheral accessories or parts before you ship the Product. LeCroy 
does not accept liability for lost or damaged peripheral accessories, data or software.

LeCroy owns all parts removed from Products it repairs. LeCroy may use new and/or 
reconditioned parts, at its sole discretion, made by various manufacturers in performing 
warranty repairs. If LeCroy repairs or replaces a Product, the Warranty Period for the 
Product is not extended.

If LeCroy evaluates and determines there is "no trouble found" in any Product returned 
or that the returned Product is not eligible for warranty coverage, LeCroy will inform you 
of its determination. If you thereafter request LeCroy to repair the Product, such labor and 
service shall be performed under the terms and conditions of LeCroy's then current repair 
policy. If you chose not to have the Product repaired by LeCroy, you agree to pay LeCroy 
for the cost to return the Product to you and that LeCroy may require payment in advance 
of shipment.



UWBTracer User Manual  Limited Hardware Warranty

LeCroy Corporation  143

General Provisions
THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. YOU MAY HAVE 
ADDITIONAL RIGHTS THAT VARY BY JURISDICTION. LECROY'S RESPONSIBILITY 
FOR DEFECTS IN MATERIALS AND WORKMANSHIP IS LIMITED TO REPAIR AND 
REPLACEMENT AS SET FORTH IN THIS LIMITED WARRANTY STATEMENT. 
EXCEPT AS EXPRESSLY STATED IN THIS WARRANTY STATEMENT, LECROY 
DISCLAIMS ALL EXPRESS AND IMPLIED WARRANTIES FOR ANY PRODUCT 
INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES OF AND 
CONDITIONS OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE, AND ANY WARRANTIES THAT MAY ARISE FROM ANY COURSE OF 
DEALING, COURSE OF PERFORMANCE OR TRADE USAGE. SOME 
JURISDICTIONS MAY NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED 
WARRANTY LASTS, SO THE PRECEDING LIMITATION MAY NOT APPLY TO YOU.

LECROY DOES NOT ACCEPT LIABILITY BEYOND THE REMEDIES SET FORTH IN 
THIS LIMITED WARRANTY STATEMENT OR FOR INCIDENTAL OR 
CONSEQUENTIAL DAMAGES INCLUDING, WITHOUT LIMITATION, ANY LIABILITY 
FOR THIRD PARTY CLAIMS AGAINST YOU FOR DAMAGES, PRODUCTS NOT 
BEING AVAILABLE FOR USE, OR FOR LOST DATA OR SOFTWARE. LECROY'S 
LIABILITY TO YOU MAY NOT EXCEED THE AMOUNT YOU PAID FOR THE 
PRODUCT THAT IS THE SUBJECT OF A CLAIM. SOME JURISDICTIONS DO NOT 
ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL 
DAMAGES, SO THE PRECEDING EXCLUSION OR LIMITATION MAY NOT APPLY TO 
YOU.

The limited warranty on a Product may be transferred for the remaining term if the then 
current owner transfers ownership of the Product and notifies LeCroy of the transfer. You 
may notify LeCroy of the transfer by writing to Technical Support at LeCroy, 3385 Scott 
Blvd., Santa Clara, CA 95054 USA or by email at: support@catc.com. Please include the 
transferring owner's name and address, the name and address of the new owner, the 
date of transfer, and the Product serial number.
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Index

Symbols
.dec files 83
.dl files 122
.lic file 132
.opt files 47, 49

A
About UWBTracer

command 128
window 128

Accumulators section 116, 117
Action

button 66
pop-up menu 66
Properties dialog 67

actions
assigning 64
events 64, 69

Actions submenu 68
Adapter Cable for SCSI 8
Add Counter option 68
Add New Device button 123
Add New Device dialog box 123
Addr field 84
Advance the Sequence button 67
Agreements 127
Alias field 123
All Markers window 33
Analyzer Plug-in Module 6
Analyzer Setup dialog box 130
AND events 43
ANT connector 13
antenna 6
antenna connector 13
Any Device checkbox 56
API 1
application programming interface 1
assigning actions 64
automatic update 130
Automation API 1

Available Events Area 58

B
Band Group/TF Code field 56
Band IDs field 56
basic components 5
beacon switch 56
Beep When Trigger Occurs option 52
binary files, debugging 52
Bit Order section 48
Board Adapter for Hirose 608-pin Connectors 10
Board Adapter for Hirose 68-pin Connectors 10
Board Adapter for IDE 40-pin Connectors 9
branching 77
buffer 53

size 53
Buffer Size slide bar 53
build number 128
Bulk/Int Transfer field 86
burst preamble 56
Bus Utilization 46, 118
BusEngine

files 127
updating 130

BusEngineRawTracexxxx.dat file 52
buttons

bus utilization 119

C
Cable Adapter 9
cables

pin assignments 135
Calculate button 111
calculating timing 32
CATC 5K platform 5
CATC BusEngine protocol processor 1
CDID field 125
CD-ROM for installation 5
Cell pop-up menu 65
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cells 62
highlight 63
types 62

Change Default Location command 54
channel

selecting 56
channel change 56
Channel field 56, 116, 117
Channel Sync Mode section 55
CHID field 124
Class request, decode 94
Class/Vendor decoding 83
Class/Vendor Decoding field 84
Class/Vendor Decoding Groups menu 85
Class/Vendor Endpoint Decoding

field 86
menu 87

Class/Vendor endpoint RPipes decoding 90
Clear marker command 31
Color section 47
Color, Format, and Hiding tab 47
colors

options 24
setting 47

Comment field 29
comments 29
components 5
Config Status Indicator 58
Configuration Name setting 47
connections

devices 11, 135
connectors 139
Context area 43
Continue capturing MPI signals during PHY Reset
Cycle 57
Control Transfer field 91
Copy Event to option 68
copying events 68
copyright notice ii
counters 68

setting 73
CTRL key 104
Current Version field 130
Custom tab 47

D
data

formats 48
invalid 48
traffic 27

Data options 46
data types 47
data.uwb file 27
date and time data 48
debug binary file 52
Debug section 52
Decode

buttons 23
decoding options 83
general options for requests 91

decode
class request 94
endpoint 95
endpoint RPipes 90
hub status 95
layout 98
request recipient 84
Request rRPipe 89
requests 93
standard request 93
toolbar 23
vendor requests 95

Decode ... Request command 94
Decode as ... Endp command 95
Decode Standard Request command 93
decoded traffic 35
decoder files 83
decoding

assigning 83
refresh 91

default file name 27
default.rec recording options file 54
Delete button 68
Delete Device button 126
Delete This Event option 68
deleting events 68
Device Address field 123
Device List window 122
Device Tracking section 56
Device Type field 123
Device Type Specific Settings tab 124
devices

adding 123
connections 11, 135
deleting 126
editing 126

device-specific errors 115
dimensions 139
direction

search 28
Direction field 86
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Direction of find 44
disclaimer notice ii
Display License Information 131
Display Options

command 45
General tab 46
loading 49
saving 49
window 45

displaying traces 35
downloading 129
dragging buttons 62
DUTs checkbox 123

E
Edit Comment command 29
Edit Device button 126
Edit Marker command 31
Edit Marker for Frame # comment window 31
Edit Trace Comment Dialog box 29
Enable Tips setting 46
Endp field 86
Endpoint RPipes

dialog box 90
tab 90

Endpoints
dialog box 86
tab 86

endpoints
decoding 95
RPipes 90

Entity field 130
environmental conditions 139
Error Occurrences graph 115
Error Report setting 46
Error Summary command 110
Errors

Header 115
PHY Payload 115
PHY Unsupported Rate 115

errors
count 110
device-specific 115
general 115
summary 110

Errors occurrences graph 114
Errors report 103
EUI-48 field 123

Event buttons
creating 61
dragging 62

Event Groups pane 43
Event Navigation

menu 105
options 105

Event pop-up menu 68
Event Properties dialog 68
Event Trigger recording type 52
events 69

actions 64, 69
buttons 61
context 43
copying 68
deleting 68
displaying 39
examples 71
filters 76
finding 42
logical relations 43
moving 68
OR 74
searching 39, 42

examples
events 71

exclusion of events 43
expiration

maintenance 131
EXT DATA connector 14
External Trigger Pulse

HIGH option 67
LOW option 67
TOGGLE option 67

F
features 2, 17

named 131
physical 5

fields
formats 48
hiding 49
options 46

File Information window 102
File menu 19
file name

default 27
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files
BusEngine 127
decoder 83
firmware 127
sample 18
script 83
Script Decoder 83
trace 54

Filter In
action 66
option 66

Filter Out
action 66
option 66

filtering in 76
filters 58

events 76
Find

command 42
window 43

Find All option 44
Find Next Occurrence command 91
firmware

files 127
updating 130

Follow Beacon Switch checkbox 56
Follow Burst Preamble checkbox 56
Follow Channel Change checkbox 56
Fonts

changing 46
options 46

Force Resynchronization checkbox 57
Format

options 24
section 48

formats
field 48

formatting traces 24
Frame Occurrences graph 114
frames

beginning 28
displaying 40
markers 40
marking 30

front panel 13

G
General buttons 22
general errors 115
General Miscellaneous dialog box 52

General Settings tab 123
General Statistics area 112, 116
General tab

Display Options 46
Recording Options 51, 52

Go to
command 41
Marker command 30, 40
PLCP/Packet/Transaction/Transfer command

40
Trigger command 39

Graph area 112
Graph Area Properties dialog box 114
graphs

Graph Areas menu 121
Grid Lines option 105
Grid View 122
Group and Color column 47

H
Header Error 115
Help menu 21, 128
Hid .dec file 83
Hidden checkbox 49
Hide

buttons 22
options 24

Hiding section 49
Hierarchy Lines setting 46
HOST connector 14
Host field 84
HTML or a Grid Format button 122
HTML View 122
humidity 139

I
independent sequences 82
Installation CD-ROM 5
intersection of events 43
invalid data 48
Investment Protection Agreement 127

K
Keep Across Recordings checkbox 85

L
layout 98
Layout command 99
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LeCroy website 129
LED 13
left mouse button 24
levels

traces 35
license

agreement 132
information 131
key 127, 132
updating software 132

License window 131
linking states 67
looping 77
Loss-of-Sync Timeout field 57
LQI By Device section 116, 117

M
MAC Addr (Address) Mask field 56
MAC-PHY Interface bus 1
MAC-PHY Interface Frame trace viewing level 36
Main Display Area 58
main window 17
Maintenance Agreement 127
maintenance expiration 131
Manual Trigger

recording type 52
Map Endpoint to Class/Vendor Decoding command
86
Map Request Recipients to Class/Vendor Decoding
command 84
Marker bar 31
markers 30

clearing 31
displaying 40
editing comments 31
setting 30

Mass Storage .dec file 83
menu bar 19
menus

graph areas 121
view settings 120

messages
recording 27

Misc button 52
Move Event to option 68
moving events 68
MPI

checkbox 57
section 57

MPI ADAPTER connector 13

MPI Adapter connector 13
MPI bus 1
MPI button 36
MPI channel 13
MPI Frame-Level view 36
MPI Frames report 103
MPI indicator 13
MPI Kit 8
MPI section 57
MPI Wire Activity section 116
Multi-band OFDM

technology 3
multi-state sequences 60, 77

N
navigating

frames and packets 108
New Event

button 61
option 65
pop-up menu 61

No Decoding option 85
NOT event 43
number data 48
Number of analyzer devices connected section
116, 117
numbers 48

O
Only DUT checkbox 56
Open Recording Options in a dialog link 103
operating range 139
options

checkboxes 52
recording 54

Options button
Traffic Summary 105

options files 47
recording 54

Options Name field 54
OR events 43, 74
Origin of find 44
out-of-synchronization 57
output signals 67

P
packet errors 48
packets

displaying 40
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panels 13
PCLK clock pulse 57
PHY Payload Error 115
PHY Unsupported Rate 115
physical features 5
pin assignments

cables 135
PKT button 36
platform 5

status 13
PLCP/Packet/Transaction/Transfer dialog box 40
Plug-in Module 6
pop-up menus 24

Recording Rules 58
position

initial 28
post-triggering

percentages 53
POWER 12 VD connector 14
power requirements 139
power supply 5
Probe Cable for IDE 40-pin Connectors and Hirose
68-pin Connectors 9
probe cables

pin assignments 135
probe connector 2
program

starting 17
Progress Indicator 27
Prompt each time option 105
Properties

Graph Area 114
option 65

Properties options
actions 67
events 68

protocol
information 103
units 112

PTP .dec file 83
Pulse High format 67
Pulse Low format 67
Purchased column 131

R
range

by type 106
Readme file 128

Real-Time Statistics
buttons 113
setting 46
window 112
window tool bar 113

rear panel 14
Recipient field 84
Record menu 19
Recorded Data files 28
recording

activity 28
messages 27
progress 27
status 27

Recording Options
command 51
default 54
miscellaneous 55
window 51

Recording Rules 69
page 58, 60
pop-up menus 58
tab 51
toolbar 58, 59

Recording Status window 28
Recording Type box 52
reference points 32
refresh 91
Refresh Decoding for this Trace File command 91
registration card 141
Report menu 20, 101
reports 101
Reports buttons 23
Request Recipient and Endpoints dialog box 84
Request RPipes 89

dialog box 89
tab 89

Required Version field 130
Restart All option 67
restart options 67
Restart the Sequence option 67
Restore Factory Presets command 47
Return Material Authorization Number 142
RF & MPI

page 55
tab 51

RF and MPI
recording options 55

RF channel 13
RF checkbox 55
RF indicator 13
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Right click cell context menu setting 46
right mouse button 25
Row Selection option 105
rows

timestamped 35
RPipe field 89
RPipes 89

endpoints 90
RSSI By Device section 116, 117
rules

restarting 67
validity 58

S
sample files 18
Samples on Negative Edge of PCLK checkbox 57
Save as Default button 54
Save External Interface Signals option 52
Scan Channels checkbox 55
Scan Time per Channel field 57
Script Decoder

files 83
Manual 83

Script Decoding language 83
script files 83
scroll bar 29
Search

command 39
menu 20, 39

search
all 44
direction 28, 44
hidden 44
origin 44

searching 39
Select Sync Channel window 55
Sequence cells 62
sequences

independent 82
restarting 67

serial number 128
servicemarks ii
Set Marker feature 30
settings

views 28
Setup menu 19, 130
Show hidden items option 105
Signal Capture section 57

signals
output 67

single-state sequence 60
Skip hidden items option 105
Smart Card .dec file 83
Snapshot recording type 52
software

features 17
license 132
license key 127
starting 17
updating 127, 129
version checking 128

specifications 139
Specify Action option 68
Specify Trace File Name dialog box 54
SrcID (Source ID) Mask field 56
Standard .dec file 83
Standard colors 47
Start command 52
Start Recording button 52
starting

software 17
State cells 62
states

linking 67
Status bar 26
Status field 130
STATUS indicator 13
Still Image .dec file 83
Stop button 28
Stop Recording button 52
storage range 139
Store into Raw Data Debug file checkbox 52
summary

statistics 112
traffic 103

Support 142
page 129

SYNC IN connector 14
SYNC OUT connector 14
Sync to Channel checkbox 55
synchronization

multiple channels 55
Synchronization Cable 7

T
Technical Support 142
text 48
Three-Year Investment Protection Agreement 127
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Tight Columns option 105
Time from Marker command 32
timeout period 57
times 48
Timestamp At The Beginning setting 46
time-stamped rows 35
timing 111

calculations 32
events 32

Timing and Bus Usage Calculator 32
Timing Calculations command 111
Timing Calculator 111
Tool Tips 18
Toolbar 22

Recording Rules 58
TRA button 37
trace files 54

names 54
opening 18
recordings 54

Trace View 2
displaying 45

Trace Viewing Level
icons 36
section 36
setting 46

traces
decoded 35
displaying 45
displays 35
file information 102
finding 42
formatting 24
items 41
levels 35
manipulating 35
navigating 108
navigation 105
range 106
reading 35
searching 39
statistics 112
tooltips 18
viewing levels 35

trademarks ii
traffic

analyzing 101
data 27
decoded 35
summary 103

Traffic Summary
Email 103
errors 110
example 104
navigating 108
options 103, 105
range 103, 106
setting 46
toolbar 103
window 103

transfers
displaying 40

transitions
displaying 40

Trigger
button 52
event 52
option 66
options 67
position 53

Trigger Cable 7, 133
trigger events

displaying 39
Trigger Position

settings 53
slide bar 53

triggering 27
triggers

displaying 39
position 53
setting 58

TRIG-IN/TRIG-OUT BNC Y-cable 133
Type field 84

U
Unhide Cells command 24
union of events 43
units 112
Universal Serial Bus Specification 94
Update BE/FW command 130
Update button 131
Update Device command 132
Update License

command 132
dialog box 132

updates
license 131
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automatic 130
BusEngine 130
firmware 130
manual 130
software 127, 129

uploading 27
activity 28

USB Device Requests 91
USB Implementers Forum 3, 94
USB/WUSB Device Request menu 91
USB-IF 94
USB-IF organization 3
User Notes field 123
User-Defined Find Events window 42
UWB Analzyer Plug-in Module 6
UWB Device List Saved File 122
UWB technology 1, 3

V
version

checking 128
number 127

Vertical Stand 5
Video .dec file 83
View ... Fields Dialog Layout dialog box 99
View Fields for ... Class Requests text box 94, 95
View Fields for ... Endp text box 95
View Fields for Standard Request text box 93
View menu 21
viewing levels 35
views

settings 28
Virtual .dec file 83

W
WAddr field 89
warranty

coverage 141
limited 141
period 141
service 142
transferring 143

WASEG button 37
WAXFR button 38
website 127

LeCroy 1
USB-IF 3
WiMedia 3

weight 139
WiMedia Alliance 3
WiMedia-compliant devices 1
window

main 17
Window menu 21
Wire Adapter .dec file 83
Wireless Personal Area Network 3
Wireless-USB devices 3
WPAN network 3
Wrap setting 46
wrapping 29
WUSB Device Requests 91
WUSB devices 3
WUSB Packet-Level view 36
WUSB Packets report 103
WUSB Transaction-Level view 37
WUSB Transactions report 103
WUSB Transfer-Level view 37
WUSB Transfers report 103
WUSB Wire Adapter Segment-Level view 37
WUSB Wire Adapter Transfer-Level view 38
www.LeCroy.com/support.html file 129

X
XFR button 37

Z
Zip file 129
Zoom Level setting 46
zooming 28
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